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CHAPTER 1

Introduction
As soon as you start a project, you can do any number of things with it. Technically, you could build
the final output immediately. However, if it is a new project with a new Word document, building the
output right away would not do your end users much good, since the output does not yet have much
real substance. The project needs content, links, navigation, and all of the other elements necessary
to help your end users.

This chapter discusses the following:

Source Documents and Content 8

Templates 11
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Source Documents and Content
You can add multiple Microsoft® Word source documents to your project, and within those you can
add many kinds of elements and objects. Some features (e.g., images, lists, tables) are built into
Word and therefore always available, whether the document is part of a Doc-To-Help project or not.
Other features are unique to Doc-To-Help and are available in Word through the Doc-To-Help ribbon,
Target ribbon, Project ribbon, and Doc-To-Help Project panel.

Project Elements and Objects
In addition to the elements and objects that you add within a Word source document, there are
other features (e.g., indexes, groups, related topics, custom tables of contents) that you can add
and manage in the Doc-To-Help Project panel. See the online help or Touring the Workspace Guide
for more information.

Elements and Objects That You Can Add to a Project
Following is a list of elements and objects that you can add to your source documents or within the
Doc-To-Help project. We're not listing the many elements and objects that are built in to Word. For
information about adding those kinds of features, see the online Help provided with Word. Instead,
we are focusing on the elements and objects that are specific to Doc-To-Help.

Some of these features can be used in online output as well as print-based output, whereas some
are for online output only.

n Documents You can add new or existing Word documents to your project. See "Adding,
Renaming, and Removing Documents" on page 14.

n ActiveX Controls These controls can be used to provide features in compiled HTML Help sys-
tems (CHM files). See "ActiveX Controls" on page 55.

n Conditions A condition is a single-sourcing feature that you can apply to files or to different
areas of your content, so that some information displays in some outputs but not in others. It
is a key feature when it comes to single-sourcing in Doc-To-Help. See "Conditions" on page 56.

n Glossaries A glossary is a list of specialized words with their definitions, accessed in online out-
put or placed at the end of a PDF. When you create a new Doc-To-Help project, a glossary doc-
ument is added automatically. However, you can delete this file or flag a different document
as your glossary. Whenever you like, you can add glossary terms to the file. See "Glossaries"
on page 67 and "Adding Terms to the Glossary" on page 68.
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n Image Maps You can insert images into your source documents, using the standard options
available in Word. (We recommend using the "Insert and Link" option, and placing images in
your Media folder.) For online outputs, you can create hotspots from an image that link to top-
ics, keywords, or groups. See "Images" on page 69 and "Creating Image Maps" on page 73.

n Indexes Index entries are also called "keywords" (or K-links). They will display in your output in
an index. See "Indexes" on page 76.

n Margin Notes Margin notes are used to place text or images in the left margin of a manual,
next to the main body of the text. Margin notes do not appear in online outputs unless you
explicitly link them to the text, where they will appear as popups. See "Margin Notes" on page
81.

n Multimedia In the Doc-To-Help ribbon in Word, there is an option named "Multimedia" that lets
you insert video files and embed online videos. See "Multimedia " on page 83.

n Navigation Links A navigation link is a feature that points to additional information from a spe-
cific area in a topic or document. This can include basic links, cross-references, inline text
effects (expanded, drop-down, popup), expanding/collapsing sections, groups, and related top-
ics. See "Navigation Links" on page 92.

n Tables You can quickly insert a table into a Word document using the Doc-To-Help Special For-
matting toolbar or ribbon. The table will be pre-formatted with the correct Doc-To-Help styles,
and you can specify borders, indentation, and shading of the heading row. See "Tables" on
page 112.

n Tables of Contents Doc-To-Help automatically creates a table of contents (TOC) for you
based on the structure of your documents. But you can create a custom TOC (you can even
have different TOCs for different targets) if you wish. See "Tables of Contents" on page 114.

n Variables Variables allow you to write content once, and manage it in one place for reuse
across your project. When adding a new text variable (not a rich content variable), you can
now select one of three types: Text, Version, or Date/Time. See "Variables" on page 136.

NOTE: Doc-To-Help supports DOC, DOCX, DOCM, and RTF files.

NOTE: These features are all available through Microsoft Word.
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NOTE: Doc-To-Help styles reside in individual Doc-To-Help templates (such as D2H_NORM.-
dotx), so you should create your files using a predefined Doc-To-Help template and edit it to
your specifications.
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Templates
Word uses template files (DOTX) whenever you create a new Word document. Depending on the
template you use, various styles are already available for you. Doc-To-Help provides predefined tem-
plates to determine how your content will look and work. The name of these templates all begin with
a D2H prefix (e.g., D2H_NOMARGIN.dotx) and contain both Word styles and Doc-To-Help's special
styles, which you apply to content in your Word source documents. Most templates are designed for
print-based outputs, while a couple are available for online outputs. In Doc-To-Help projects, there
are two kinds of Word templates that you will use: source and target.
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CHAPTER 2

Source Documents
You can add multiple Microsoft® Word source documents to your project, and within those you can
add many kinds of elements and objects. Some features (e.g., images, lists, tables) are built into
Word and therefore always available, whether the document is part of a Doc-To-Help project or not.

But there are other features that are unique to Doc-To-Help (e.g., conditions, image maps, inline
text, variables). When you open a Word source document that is part of a Doc-To-Help project, you
will notice three additional ribbons displayed for using the unique elements of Doc-To-Help: Doc-To-
Help, Target, and the Project ribbons.

Depending on the source template you used to create the document, a ribbon called "Doc-To-Help
Special Formatting" may also be available.

NOTE: If you want to use the Special Formatting ribbon in your source document, be sure
to select the D2H_SMAL.dotx, D2H_SMAL_A4.dotx, D2H_NORM.dotx, or D2H_NORM_A4.-
dotx template when creating a new document. If your source document is using a different
template, and you switch to one of these four templates, the Special Formatting ribbon will
not be available.

For documents where this ribbon is not available, use the Bullet, Numbering, and Table buttons in
Word's native ribbons.

In addition to Doc-To-Help's special Word ribbons, the Doc-To-Help Project panel lets you add other
unique elements to your source documents, such as links to variables, keywords, and topics.
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This chapter discusses the following:

Adding, Renaming, and Removing Documents 14

Converting DOC Files to DOCX 17

Converting Documents to HTML5 18

Setting Document Properties 19

Finding Projects Containing a Source Document 22
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Adding, Renaming, and Removing
Documents
You may add, rename, and remove Word documents. You can also designate a specific document
to serve as a glossary.

HOW TO ADD A NEW DOCUMENT TO YOUR PROJECT

1. In Word, click on the Documents view in the Doc-To-Help Project panel.

2. Click the Create New Document button .

3. Choose the Word document. Enter a name and click Save. The document opens and is added
to the Documents window view.

NOTE: You can also add a new document by opening the Project ribbon, and clicking the
Add button in the Documents section of this ribbon.

HOW TO ADD AN EXISTING DOCUMENT TO YOUR PROJECT

1. In Word, open the Documents window view in the Doc-To-Help Project Panel.

2. Click the Add Existing Documents button . The Document Import Wizard opens.

3. Choose Local. This option imports documents located on your computer or a network.

NOTE: If you want to add documents from a SharePoint Library, choose SharePoint
instead. For more information about SharePoint and adding documents using that
method, see the online Help or the Project Management Guide.

4. Click Next.

5. Click Add File(s) or Add Folder to select your documents or a folder containing multiple doc-
uments. Then click Open or OK in the dialog when finished.
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NOTE: If you attempt to add a document to your project that has the same name as
one that already exists in your source document folder, it will display in the wizard
with a red X icon next to it. Since you cannot import a document with the same name,
the Import button will be disabled.

6. (Optional) In the Copy files to field you can select a location other than the default (i.e., the
Documents folder in your project) to store the document(s). Your original documents will
remain in their original location.

7. (Optional) You can select Leave documents at their original location if you do not want to
copy them to your project, but this is not recommended, because references to other doc-
uments in your project may be broken in your targets.

8. Click Import. The imported files will appear in the Documents window pane. You can use the
arrow buttons in the local toolbar to rearrange the files as you wish.

NOTE: You can also add a new document by opening the Project ribbon, and clicking the
Add button in the Documents section of this ribbon.

NOTE: You can also drag-and-drop an existing document from Windows Explorer into the
Documents window pane, but you should copy it into the appropriate project folder first. By
default, this folder is named "Documents." These default names can be changed using the
Project Settings dialog. See the online Help or the Project Management Guide

HOW TO RENAME A DOCUMENT

1. In Word, in the Documents window view, right-click on the document and choose Rename
Document.

2. Type a new name and press Enter.

HOW TO REMOVE A DOCUMENT

1. InWord, in the Documents window view, right-click on the document and choose Remove
Document.

2. Click Yes.
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HOW TO DESIGNATE A DOCUMENT AS THE PROJECT GLOSSARY

n In Word, in the Documents window view, right-click on the document and choose Glossary.
The icon next to the document changes to reflect its purpose.

For more information on glossaries, see "Glossaries" on page 67.

After adding a new document to your project, you should build the target. This processes the doc-
ument and adds its topics to the project (see "Topics" on page 118).
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Converting DOC Files to DOCX
You can upgrade older Word documents (DOC files) in your project to the newer DOCX format. The
DOC format is from Word 2003 and older versions of Word. The DOCX format—an open standard
format based on XML—was introduced in Microsoft Office 2007.

HOW TO CONVERT DOC FILES TO DOCX

1. Open a Doc-To-Help project that contains at least one document with a DOC extension.

2. Select File > Doc-To-Help.

3. In the Doc-To-Help menu in Word, click the Common Tasks submenu option under the Project
section.

4. Click the Convert Doc to DocX button. You will see a prompt to start the operation; click the
appropriate button to begin the conversion. The prompt message depends on whether a pro-
ject is shared or not. For shared (team) projects, you need to check out the project.

After a successful conversion, all documents in the project will be DOCX, and all links in all Word doc-
uments will be updated appropriately.

NOTE: If any error occurs while converting documents, Doc-To-Help attempts to restore
everything (documents and the project) to the initial state (before starting the conversion).
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Converting Documents to HTML5
You can convert a Word document that is already part of your project to HTML5. The file extension
of the converted document will be .xml. The primary reason for converting Word documents to
HTML5 is to then import your Doc-To-Help project to MadCap Flare.

HOW TO CONVERT MULTIPLE DOCUMENTS TO HTML5

1. In Word, open the Documents window view in the Doc-To-Help Project panel, and click the
Convert Multiple Documents to HTML5 button .

If you want to convert just a single document, you can right-click on the document in the Docu-
ments window view and choose Convert to HTML5.

The Convert Documents to HTML5 dialog opens.

2. By default, the converted documents will be saved to their original location. If you would like to
save them to another location, choose Save converted files to and click the Browse button).

3. The "Keep backup copy" check box is selected by default. If you want the option to revert to
the original source documents, leave it selected. The files will be saved with a .backup file
extension.

4. Confirm the Word Style Map (the Word to HTML5 styles map file). Click the Browse button to
change it.

5. If you would like to convert one or more files individually, select the document name(s) on the
left, then select the Use individual conversion settings check box.

6. Choose the desired options.

7. Click the Convert button. The files are converted and appear in the Documents window pane.
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Setting Document Properties
The Document Properties dialog is used to view or change the properties of a document. If you
would like to view or change the properties of a single topic, use the Topic Properties dialog (see
"Viewing/Changing Topic Properties" on page 132).

HOW TO SET DOCUMENT PROPERTIES

1. In Word, open the Documents window pane in the Doc-To-Help Project panel and select a doc-
ument.

2. Right-click on the document you wish to modify.

3. Select Properties. The Document Properties dialog opens.

4. Set any of the following:

DOCUMENT

n Name The read-only name of the document.

n Type Notes the document type (e.g., Word).

n File size The size of the source document.

n File modified The date and time of the last modification to the source document.

CONDITION

These can also be set and will appear in the Source group in the ribbon. See "Conditions" on
page 56.

n Platforms Sets a platform-based condition for the selected document. The document
will be included in all the target platform(s) selected. A platform includes all the targets
that produce the output specified; Online Help, HTML Help, NetHelp, Printed Manual,
etc.

n Targets Sets a target-based condition for the selected document. The document will be
included in all the target(s) selected.

n Attributes Set an attribute-based condition for the selected document. The document
will be included or excluded when creating conditional builds (e.g., internal or external.)
Use the Attributes dialog (Project > Attributes) to create custom attributes.
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SHARING

These fields only apply to documents that have been shared to a SharePoint Library. See the
online Help or the Project Management Guide.

n Document URL The location of this document on the SharePoint Library server.

n Auxiliary Files The location of this document's auxiliary files (usually graphics and video)
on the SharePoint Library server.

n First Uploaded by The name of the person who first uploaded this document to the
SharePoint Library server.

n First Upload date The date this document was first uploaded to the SharePoint Library
server.

n Last changed by The name of the last person to edit this document.

n Last download date The latest date this document was downloaded from the
SharePoint Library server.

n Checked out by If this document is currently checked out from the SharePoint Library,
the name of the person who has it checked out. If it is you, it will read "me."

ADVANCED

n Keep outline numbers When selected, outline numbers are included as part of topic
titles and are present in targets. This setting only affects the RTF files generated from
source documents; it does not affect the source documents themselves. Modifying
this setting for an individual document will override the settings for that document only.

n Adjust left indent Controls whether paragraph indentation is adjusted to account for
wide margins when building online output. By default, this check box is selected to
accommodate the standard Doc-To-Help templates. Clear this check box if you are
using custom templates and want to preserve the indentation used in your source doc-
uments.

n Include in Search If selected, search is enabled for this document in NetHelp outputs. If
cleared, this document is excluded from the search.

n Keep page breaksWhen selected, retains the page break characters in the source doc-
uments during compilation of a Printed Manual target. Clear this check box to discard
page break characters. Modifying this setting for an individual document will override
the settings for that document only.
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n Plain text popups If selected, generates a plain text-only version of the file for context-
sensitive Help topics. Modifying this setting for an individual document will override the
settings for that document only.

5. Click OK.
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Finding Projects Containing a Source
Document
Source documents sometimes belong to multiple Doc-To-Help projects. When you open a source
document in Word, you can switch between these projects so you can easily make changes to each
project.

HOW TO FIND PROJECTS CONTAINING A SOURCE DOCUMENT

1. In Word, select the Doc-To-Help ribbon.

2. In the Project section, click Select Project.

3. In the dialog that opens, navigate to the Doc-To-Help project that contains your source doc-
ument, then click Open.

NOTE: If you attempt to open a project that does not contain the open source document,
you will receive an error.

NOTE: You can also use the Find Project option if you open a source document and the
Doc-To-Help Word add-in cannot locate the project file. In this instance, the Word add-in will
open in Basic mode, and you can use the Find Project option to find a project associated
with the source document. If you find an appropriate project, the add-in will switch to Full
mode.
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CHAPTER 3

Templates and Styles
In addition to Word's built-in styles and those you create, there are several styles created by Doc-To-
Help that you will use because they let you create features not otherwise available in Word. You can
easily identify these special styles because they all begin with the prefix C1 or C1H (e.g., C1 Section
Collapsed, C1H Link Tag, C1H Popup).

Word uses template files (DOTX) whenever you create a new Word document. Depending on the
template you use, various styles are already available for you. Doc-To-Help provides predefined tem-
plates to determine how your content will look and work. The name of these templates all begin with
a D2H prefix (e.g., D2H_NOMARGIN.dotx) and contain both Word styles and Doc-To-Help's special
styles, which you apply to content in your Word source documents. Most templates are designed for
print-based outputs, while a couple are available for online outputs. In Doc-To-Help projects, there
are two kinds of Word templates that you will use: source and target.

This chapter discusses the following:

Location of Template Files 24

Source and Target Templates 25

Print-based Templates 28

Online Templates 33

Selecting None as a Template 33

Editing a Template 34

Selecting Templates 48

Copying Custom Styles to a New Template 50
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Location of Template Files
Doc-To-Help's custom templates are stored in the same location as your regular Microsoft tem-
plates:

C:\Users\<user name>\AppData\Roaming\Microsoft\Templates

The path may be slightly different depending on your operating system.

NOTE: If you uninstall Doc-To-Help and reinstall a newer version, the templates will remain
in that folder. However, if one of your customized templates uses the same name as one of
Doc-To-Help’s default templates, and there is a newer version of that template in the install-
ation, Doc-To-Help will save your version of the template to the following folder:

\\Users\<user name>\AppData\Roaming\Microsoft\Templates\Backup

The Application Data or App Data folder is a hidden folder. To show hidden folders, open the
Folder Options dialog in your operating system (Control Panel > Folder Options). Click the
View tab, under Advanced Settings > Files and folders > Hidden files and folders, select the
Show hidden files and folders radio button. Click OK.
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Source and Target Templates
In Doc-To-Help projects, there are two kinds of Word templates that you will use: source and target.

Why two kinds of templates? It has to do with function; each has a unique purpose and is associated
with different parts of the user interface.

SOURCE TEMPLATES

A source template is used when you create a new Word source document (see "Adding, Renaming,
and Removing Documents" on page 14) and author in it (see "Source Documents" on page 12). You
should always create your documents with the source templates provided by Doc-To-Help and edit
the source document as desired; this will guarantee full Doc-To-Help functionality.

EXAMPLE

If you select D2H_NOMARGIN.dotx as your source template, that is the template that
will be used when you create a new source document in the project.

When you open a source document that is part of a Doc-To-Help project, you will notice that there
are more options available in Word's Doc-To-Help ribbon. Many of these options are only available in
source documents; you will not see them in final output or templates.
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IMPORTANT: If you want to create new styles, you can do so in both your source and tar-
get template. (By creating a new style in the source template, it becomes available in your
source document so that you can apply it to content.) However, it is not necessary to edit
the formatting in a source template; it is best to leave the formatting in a source template as
it is. The source template is for your eyes only, and it would be a wasted effort to make a lot
of formatting changes in it since your end users will not see it. You should make formatting
changes on styles in your target template.

The exception to this rule is if you are creating a custom template, because any text you
add in the source template is used to create new projects. You may want to add some
formatting in the template to provide structure in new projects (e.g., adding headings).
However, you should not extensively format the template, because formatting is added
when you build your output.

IMPORTANT: You can create your own custom source templates. If you do this, it is recom-
mended that you make copies of an existing Doc-To-Help template to edit rather than cre-
ating a template from scratch. This is because Doc-To-Help templates use several
proprietary styles and bookmarks to ensure that your output builds correctly.
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TARGET TEMPLATES

A target template is used when you build the selected target. See the online Help or the Targets
Guide.

EXAMPLE

If you select D2H_PRNOMARGIN.dotx as your target template, that is the template that
will be used when you generate output for the selected target.

Also, when you select a particular target in the Target ribbon (from the Active Target drop-down),
Doc-To-Help automatically changes the Target Template drop-down to select the default template
associated with that target.

When you open Word output generated from a target template, you will notice that there are fewer
options available in Word's Doc-To-Help ribbon than if you had opened a source document. A couple
of options (i.e., Generate PDF and Master Print) are only available in the ribbon when you view out-
put because they are necessary for output but not for the source document.

NOTE: When you open a source or target template in Word, you will not see the Doc-To-
Help ribbon. This is because you do not need Doc-To-Help functionality to edit a template,
so the Doc-To-Help Word add-in opens in No Features mode. However, you can still use
Doc-To-Help's styles and variables to edit the template.
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Print-based Templates
The following table lists the variousWord template files that can be used in Doc-To-Help projects
when creating print-based output.

Notice that each source template has a complementary target template that has a similar page lay-
out. Therefore, if you select a particular source template, it is a best practice to also select its com-
plementary target template.

EXAMPLE

Let's say you add and select D2H_SIDE.dotx as your source template.
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Therefore, according to the following table, it's best to add and select D2H_PRSIDE.-
dotx as the target template.

Print-based templates often contain front matter and back matter content (e.g., title page, table of
contents, index). You can make changes to this content (e.g., title, cover image, byline, contents
heading) in the Help Targets dialog. See the online Help or the Targets Guide.

Source Templates Complementary Target Templates

D2H_FANCY.DOTX This source template
has a page layout similar to D2H_
NOMARGIN.DOTX, but it has a fancier
styles that use color and a different font.
When used with the complimentary target
template, it will have a fancy design.

In the New Project Wizard, this template is
called Fancy 8.5" x 11" Template.

D2H_PRFANCY.DOTX This is the target template that
is intended to accompany the D2H_FANCY.DOTX
source template. It includes a page layout similar to
D2H_PRNOMARGIN.DOTX, but it has a fancier
design. This includes color, an image placed behind
the text on the title page, an image placed behind the
text in the headers, and a decorative image in the
footers.

D2H_FANCY_A4.DOTX This is the source
template for A4-sized paper.

In the New Project Wizard, this template is
called Fancy A4 Template.

D2H_PRFANCY_A4.DOTX This is the target template
used to format the printed manual target (A4-sized
paper).
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Source Templates Complementary Target Templates

D2H_NOMARGIN.DOTX This is the Doc-
To-Help default source template. It will be
used unless you use your own or choose
an alternate from this list.

In the New Project Wizard, this template is
called Normal 8.5" x 11" Template (no left
indent).

D2H_PRNOMARGIN.DOTX This is the target template
used to format the printed manual target. It differs
from D2H_PRNORM.DOTX in that it does not have
the wide 2-inch left margin.

D2H_NOMARGIN_A4.DOTX This is the
source template for A4-sized paper.

In the New Project Wizard, this template is
called Normal A4 Template (no left
indent)

D2H_PRNOMARGIN_A4.DOTX This is the target tem-
plate used to format the printed manual target (A4-
sized paper).

D2H_NORM.DOTX This is Doc-To-Help’s
default source template for versions prior
to Doc-To-Help 2007. This matches D2H_
NOMARGIN.DOTX, but it has a 2-inch left
margin.

In the New Project Wizard, this template is
called Normal 8.5" x 11" Template.

D2H_PRNORM.DOTX This is the target template
used to format the printed manual target. It differs
from D2H_PRNOMARGIN.DOTX in that it has a 2-inch
left margin.

D2H_NORM_A4.DOTX This is the source
template for A4-sized paper with a 2-inch
left margin.

In the New Project Wizard, this template is
called Normal A4 Template.

D2H_PRNORM_A4.DOTX This is the target template
used to format the printed manual target (A4-sized
paper).
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Source Templates Complementary Target Templates

D2H_FANCY_POLICIES.DOTX This source
template is used to create policies
& procedures documents. It has sample
text and headings that you can use as a
starting point for these manuals. It is
based on D2H_FANCY.DOTX and uses the
same styles and page layout as in that
template.

By default, the headers in this template
are numbered.

In the New Project Wizard, this template is
called Policies & Procedures 8.5" x
11" Fancy Template.

D2H_PRFANCY_POLICIES.DOTX This is the target
template that is intended to accompany the D2H_
FANCY_POLICIES.DOTX source template. Like the
PR_FANCY.DOTX target template, this template
includes color, an image placed behind the text on
the title page, an image placed behind the text in the
headers, and a decorative image in the footers.

D2H_FANCY_POLICIES_A4.DOTX This is
the source template for A4-sized paper.

In the New Project Wizard, this template is
called Policies & Procedures A4 Fancy
Template.

D2H_PRFANCY_POLICIES_A4.DOTX This is the tar-
get template used to format the printed manual tar-
get (A4-sized paper).

D2H_NOMARGIN_POLICIES.DOTX This
source template is used to create policies
& procedures documents. It has sample
text and headings that you can use as a
starting point for these manuals. It is
based on D2H_NOMARGIN.DOTX and
uses the same styles and page layout as
in that template.

By default, the headers in this template
are numbered.

In the New Project Wizard, this template is
called Policies & Procedures 8.5" x
11" Plain Template.

D2H_PRNOMARGIN_POLICIES.DOTX This is the tar-
get template used to format the printed manual tar-
get for a policies & procedures manual.
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Source Templates Complementary Target Templates

D2H_NOMARGIN_POLICIES_A4.DOTX
This is the source template for A4-sized
paper.

In the New Project Wizard, this template is
called Policies & Procedures A4 Plain Tem-
plate.

D2H_PRNOMARGIN_POLICIES_A4.DOTX This is the
target template used to format the printed manual
target (A4-sized paper).

D2H_SIDE.DOTX This is the source tem-
plate for sidehead source documents.

In the New Project Wizard, this template is
called Sidehead 8.5" x 11" Template.

D2H_PRSIDE.DOTX This is the target template used
to format the standard sidehead printed manual.

D2H_SIDE_A4.DOTX This is the source
template for sidehead source documents
on A4-sized paper.

In the New Project Wizard, this template is
called Sidehead A4 Template.

D2H_PRSIDE_A4.DOTX This is the target template
used to format the standard sidehead printed manual
(A4-sized paper).

D2H_SMAL.DOTX This is the source tem-
plate used to format small-sized manuals
on 8.5" x 11" paper.

In the New Project Wizard, this template is
called Small 8.5" x 11" Crop-Marked Tem-
plate.

D2H_PRSMAL.DOTX This is the target template used
to format the standard small printed manual.

D2H_SMAL_A4.DOTX This is the source
template used to format small-sized
manuals on A4-sized paper.

In the New Project Wizard, this template is
called Small A4 Crop-Marked Template.

D2H_PRSMAL_A4.DOTX This is the target template
used to format the standard small printed manual
(A4-sized paper).
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Online Templates
If you are generating online output from Doc-To-Help, you will normally use the primary online tem-
plate: D2H_HTML.dotx.

Selecting None as a Template
When selecting source and target templates, you also have the option of selecting (none). If you do
this, Doc-To-Help will use the same template that is used if you were to create a new blank doc-
ument in Word.

NOTE: If you have existing Word documents that use custom styles, you can copy all of
those styles from your templates over to Doc-To-Help’s custom templates using Word’s
Organizer. And you can use the Project Styles dialog in Doc-To-Help to map your existing
styles to Doc-To-Help styles.

NOTE: If you have old projects from previous versions of Doc-To-Help, you should upgrade
those projects to the new version. Upgrading your old project is necessary if you want to
use the new version of Doc-To-Help because doing so makes changes to removed target
settings. Keep in mind that there is also a change in templates from previous versions,
which used the C1H prefix instead of the current D2H prefix, and the DOT or
DOTM extension instead of the DOTX extension. See the online Help or the Upgrading Old
Projects Guide.
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Editing a Template
There may be times that you need to edit Doc-To-Help's templates to suit your own needs. You can
do this by editing styles in the templates or by creating custom templates.

Editing Template Styles
If necessary, you can create new styles in both your source and target templates (DOTX file).
However, if you need to make modifications to the formatting of styles (e.g., change the font color
for a style from black to red), you should do so in your target template instead of the source tem-
plate or document. Keep in mind that style changes in the source template affect only the look of
the source documents, which are for your eyes only. Editing the target template changes the look of
your final output.

EXAMPLE

Let's say you change the Heading 1 style in the template to be blue. But in the source
document you create based on that template, you change the color for the style to red.
When you generate the target, Doc-To-Help ignores the formatting that you did in the
source document, and you end up with blue headings.

If you've selected a source template that includes a particular style that is not available in a target
template that you select, the source style passes through to the target.

EXAMPLE

Let's say you are using D2H_NOMARGIN.dotx as your source template. Within that tem-
plate, you create a custom style called "BigText" that has a 48-point font.

You then create a source document based on that template, and you apply the
"BigText" style to some content.

With D2H_PRNOMARGIN.dotx selected as your target template, you build the output.
The "BigText" style is not part of that template, but it passes through and you see it any-
way in the output.

TIP: It is good practice to back up your original templates so that you can restore them if
needed.
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HOW TO OPEN A SOURCE OR TARGET TEMPLATE

1. In Word, open the Project ribbon to open a source template. Or, open the Target ribbon to
open the target template.

2. To open source templates for editing:

a. Click the Edit button in the template area of the Project ribbon.

3. To open target templates for editing:

a. Click the Edit button in the template section of the Target ribbon.

HOW TO MODIFY THE FORMATTING OF A STYLE IN A TEMPLATE

1. After the Word template is open, select the Home ribbon, and at the bottom of the Styles
group click . The Styles window opens.

2. Click the style you would like to edit from the list and click the drop-down next to it. Choose
Modify. The Modify Style dialog opens.

3. Select the Format drop-down, then select the attribute you want to modify and make the
desired changes.

4. When you are done, choose New documents based on this template.

5. Click OK.

6. Save the template file.

This will only affect the look of a style.
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HOW TO ADD OR REMOVE A TEMPLATE IN DOC-TO-HELP

To add a Source Template, select the Project ribbon and click the Add button in the template sec-
tion. To add a Target Template, select the Target ribbon and click the Add button in the template
section.

To remove a Source Template, select the Project ribbon and click the Removebutton in the tem-
plate section. To remove a Target Template, select the Target ribbon and click the Removebutton
in the template section.

NOTE: Templates are stored at:

\\Users\<user name>\AppData\Roaming\Microsoft\Templates

If you uninstall Doc-To-Help and reinstall a newer version, the templates will remain in that
folder. However, if one of your customized templates uses the same name as one of Doc-
To-Help’s default templates, and there is a newer version of that template in the installation,
Doc-To-Help will save your version of the template to the following folder:

\\Users\<user name>\AppData\Roaming\Microsoft\Templates\Backup

The Application Data or App Data folder is a hidden folder. To show hidden folders, open the
Folder Options dialog in your operating system (Control Panel > Folder Options). Click the
View tab, under Advanced Settings > Files and folders > Hidden files and folders, select the
Show hidden files and folders radio button. Click OK.
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Creating Custom Templates
If you use Doc-To-Help to create specific kinds of documents, like policies & procedures manuals or
knowledge base articles, you might want to create custom templates for these documents rather
than using Doc-To-Help's standard templates. Custom templates can be used every time you cre-
ate a new document so writers do not need to cut-and-paste formatting or copy styles from tem-
plate to template. You can also provide sample text to remind writers of the information that needs
to go in each section.

HOW TO CREATE CUSTOM TEMPLATES

1. Open the Microsoft Word Templates folder, located at C:\Users\[user-
name]\AppData\Roaming\Microsoft\Templates. Copy the source and target templates that
you want to use as a basis for your custom template, and paste them in a new location, such
as your desktop or a network drive.

IMPORTANT: It is recommended that you make copies of an existing Doc-To-Help
template to edit rather than creating a template from scratch. This is because Doc-
To-Help templates use several proprietary styles and bookmarks to ensure that your
output builds correctly.

2. Open the source template. Make any changes to the default text. You can add sample head-
ings and default text. Any content that appears in the source template will appear in new doc-
uments created using the template.

NOTE: If you create styles in your custom templates, remember to define their
authoring behaviors in Doc-To-Help using the Project Styles dialog.
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TIP: If you are creating custom templates and you edit the first-level heading (labeled
"Chapter 1" in most templates), be sure that the ChapterHeading bookmark does not
get deleted. The ChapterHeading bookmark is necessary for Doc-To-Help to know
where to insert content when building output. If it is deleted, you may end up with
duplicate content.

To do this in Word, select the Insert ribbon, then click Bookmark. The Bookmarks dia-
log opens. If the ChapterHeading bookmark is not listed in the dialog, you can add it. If
it is already listed, you do not need to do anything. For more information, see the
Microsoft Word online Help.

3. Save the source template. Be sure to save it as a .DOTX file and use a unique name.

NOTE: It is important that you save your templates to a shared location, such as a net-
work drive, if you are working with other authors.

If you are working alone, you can save the template to your C:\Users\[user-
name]\AppData\Roaming\Microsoft\Templates folder.

4. (Optional) Open the target template. If you created any styles in the source template to use
while creating your document, use the Word Organizer to copy those styles over to the target
template.

NOTE: The placeholder text in the target template dictates where your content will
be added in the output. Do not change the text in the target template.

5. Save the target template. Be sure to save it as a .DOTX file and use a unique name.

NOTE: Be sure to save the template as a unique file even if you did not make any
changes to it.
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NOTE: It is important that you save your templates to a shared location, such as a net-
work drive, if you are working with other authors.

If you are working alone, you can save the template to your C:\Users\[user-
name]\AppData\Roaming\Microsoft\Templates folder.

6. Create a new Doc-To-Help project. When given the option to select a template, select Add my
own set of styles from the drop-down, then select your custom template.

7. (Optional) When the Doc-To-Help project opens, be sure to add your target template to the
project to use when building output. You will not need to do this if you are using NetHelp as
your target, because the HTML template is already selected by default.

EXAMPLE

Let's say your company writes knowledge base articles. Your articles need to include
five headings: a title, a summary, a description, a solution, and an attribution. You
decide to create a custom template that includes headings for each of these sections.
Because the articles are often written by different authors, you also want to include
some sample text to guide the authors when they create a new article so each article
will be written the same way and have a common voice.

To do this, you first create a copy of the source Doc-To-Help template most like the
template you want to create. You decide to use D2H_NOMARGIN.dotx as a base for
your new template because it is basic and you do not need any extra frills for your know-
ledge base articles.
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For now, you can save the copy of the D2H_NOMARGIN.dotx template to your desktop,
since you will be making changes to it. It is important to save a separate copy of the
template in a new location, such as your desktop, so it does not get mixed up with the
original Doc-To-Help template while you are making changes.
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Open the document and make your changes. You add a Title placeholder as a Heading
1, and the rest of your headings as Heading 2s. You also add some sample text in each
section. You do not make any style changes.

When you are done, your sample document looks like this:

Save the new source template as Knowledge_Base.dotx. Since you are working with
several other authors, be sure to save it to a network drive so everyone has access to it.

Then you copy the coordinating Doc-To-Help target template (D2H_PRNOMARGIN.-
dotx) to your desktop (again, it is important to keep this copy separate from the original
to prevent errors).
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Open the copy of the target template. Save it as PR_Knowledge_Base.dotx so you can
distinguish it from your source template. You do not make any other changes. Be sure
to save your new template to the network drive so other authors can access it.

Once you have saved your copies to the network drive, you can remove the temporary
copies from your desktop.

Later, your authors create a new Doc-To-Help project using the Knowledge Base
source template.
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When they create a new document, they see all of the default text you added to the
template. They are able to use this text as a guideline to create the knowledge base art-
icle.
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The authors also add the new Knowledge Base target template to the project, and use
it when building printed output.
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IMPORTANT: It is recommended that you update your source templates when you update
to ensure that your output is built the way you intended.
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Selecting Templates
Predefined templates are used to determine how content will look in both the source documents
and the final output.

Doc-To-Help automatically assigns the default source template (D2H_NOMARGIN.DOTX) and its
complementary target template (D2H_PRNOMARGIN.DOTX) after you create a new project.
However, you can select different templates if you want.

HOW TO SELECT A DEFAULT SOURCE TEMPLATE FOR NEW DOCUMENTS

The source template chosen in the Doc-To-Help interface is associated with new source doc-
uments that you create. See "Adding, Renaming, and Removing Documents" on page 14.

1. In Word, select the Project ribbon.

2. From the Source Template drop-down, select the template to be used for new documents so
that a check mark is added next to it.

If you want to select a template not shown in the list, click Add and use the dialog to choose a
template file.

NOTE: This option may also be set in the Project Settings dialog (Default Template field).
See the online Help or the Project Management Guide.

NOTE: If you want to use the Special Formatting ribbon in your source document, be sure
to select the D2H_SMAL.dotx, D2H_SMAL_A4.dotx, D2H_NORM.dotx, or D2H_NORM_A4.-
dotx template when creating a new document. If your source document is using a different
template, and you switch to one of these four templates, the Special Formatting ribbon will
not be available.
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HOW TO SELECT A SOURCE TEMPLATE FOR AN EXISTING DOCUMENT

If you have an existing document and want to associate it with a different template, you can do so in
that Word document.

1. Open the Word source document.

2. Select File > Options. The Word Options dialog opens.

3. In the left pane, click Add-Ins.

4. From the Manage drop-down, choose Templates, then click Go. The Templates and Add-ins
dialog opens.

5. In the Document template area, click Attach. The Attach Template dialog opens.

6. Select a template file, then click Open.

7. In the Templates and Add-ins dialog, click OK.

8. Save the document.

HOW TO SELECT A TARGET TEMPLATE

The target template affects the look of the target you build.

1. In Word, select the Target ribbon.

2. From the Target Template drop-down, select a template. A check mark appears next to the
template you select.

If you want to select a template not shown in the list, click Add. In the dialog, select a tem-
plate file, then click Open.

NOTE: If you have a legacy Doc-To-Help project in which you were using HTML5 files and
CSS, you can select the CSS in the Help Targets dialog or Project Settings dialog.

NOTE: You can also create custom templates.
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Copying Custom Styles to a New Template
If you have existing Word documents that have a lot of custom styles, you can copy all of those
styles from your templates over to Doc-To-Help’s custom templates using Word’s Organizer. This is
also very useful if you are creating new templates to use with Doc-To-Help and want to copy over
styles from existing templates.

HOW TO COPY STYLES USING THE WORD ORGANIZER

1. Open the Word template into which you want to want to copy your custom styles.

2. Select File > Options. The Word Options dialog opens.

3. In the left pane, click Add-Ins.

4. From the Manage drop-down, choose Templates, then click Go. The Templates and Add-ins
dialog opens.
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5. Click Organizer. The Organizer dialog opens.
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6. The left side of the dialog shows the current document, and the right side of the dialog shows
a Word default template. To remove the default template from the list and replace it with your
custom template or document, click Close File, then click Open File.

7. In the dialog that opens, navigate to the template or document that contains your custom
styles, then click Open. Your custom styles appear on the right side of the dialog.
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8. On the right side of the dialog, select the custom styles you want to copy to your new tem-
plate. Click Copy to copy each style.
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NOTE: If a style has the same name as an existing style, you will be given the option
to overwrite the existing style.

9. (Optional) If you need to delete a style, select it and click Delete. To rename a style, select it
and click Rename.

10. When you are finished copying the custom styles to your new template, click Close.

TIP: Keep a copy of your templates. If you accidentally modify or delete a style in the work-
ing copies of your templates, you can use the Organizer to restore template styles by copy-
ing them from the original template.
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CHAPTER 4

ActiveX Controls
Using the HTML Help Control button in the Doc-To-Help toolbar or ribbon, you can quickly insert
HTML Help ActiveX Controls into your Word documents. These controls can be used to provide fea-
tures in compiled HTML Help systems (CHM files). For more information on HTML Help ActiveX con-
trols, see the MSDN article "HTML Help ActiveX Control Overview"
(http://msdn2.microsoft.com/en-us/library/ms644670.aspx).

HOW TO INSERT AN HTML HELP ACTIVEX CONTROL

1. In the Word source document, place your cursor at the point you’d like to insert an HTML Help
ActiveX Control.

2. In the Doc-To-Help ribbon, click the HTML Help Control button. The HHCTRL: HTML Help Act-
iveX Control Commands wizard opens.

3. Select the command from the drop-down menu and follow the instructions as you move
through the wizard.

When you have completed the wizard, Doc-To-Help inserts code into your document. However, it
will be marked with the HTML Passthrough code condition, so the code will appear in the HTML
Help target as a control, and will be skipped in other targets.

NOTE: This is an advanced feature and many of the options available can be performed
using other Doc-To-Help functionality.

CHAPTER 4  55

http://msdn2.microsoft.com/en-us/library/ms644670.aspx


CHAPTER 5

Conditions
A condition is a single-sourcing feature that you can apply to files or to different areas of your con-
tent, so that some information displays in some outputs but not in others.

This chapter discusses the following:

What You Can Condition 57

Types of Conditions 58

Including Conditions in Your Output 61

Creating and Using Attributes 62

Marking Text as Conditional 64

Setting Topic Conditions 66

CHAPTER 5  56



What You Can Condition
With Doc-To-Help, you can condition the following:

n Text and Images See "Marking Text as Conditional" on page 64.

NOTE: Text within variables can also be conditioned. See "Inserting a Variable" on
page 145.

n Topics See "Setting Topic Conditions" on page 66.

n Documents See "Converting DOC Files to DOCX" on page 17.
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Types of Conditions
You can use three types of conditions: platforms, targets, and attributes.

Platforms are default output types, and targets will vary by project, but attributes are created by you
to meet your specific needs.

PLATFORMS

You can base conditions on an entire platform, or output type. This includes the following:

n Eclipse Help Conditioned text, topic, or document will be included in all Eclipse targets.

n EPUB Conditioned text, topic, or document will be included in all EPUB targets.

n HTML (Any) Conditioned text, topic, or document will be included in all HTML targets
(includes JavaHelp).

n HTML Help 1.x Conditioned text, topic, or document will be included in compiled HTML Help
targets.

n JavaHelp Conditioned text, topic, or document will be included in all JavaHelp targets.

n Microsoft Help 2.0 Conditioned text, topic, or document will be included in MS Help 2.0 tar-
gets.

n Microsoft Help Viewer Conditioned text, topic, or document will be included in Microsoft Help
Viewer targets.

n NetHelp Conditioned text, topic, or document will be included in NetHelp (browser-based
uncompiled HTML Help) targets.

n Online Help Conditioned text, topic, or document will be included in all online targets (i.e., all
targets except Printed Manual).

n Printed Manual Conditioned text, topic, or document will be included in Printed Manual targets
(Word and PDF).

CHAPTER 5  58



TARGETS

You can base conditions on a particular topic. This includes the following new project defaults. You
can add additional targets and delete those you don’t need.

n <Your Project Name> Eclipse Help Conditioned text, topic, or document will be included in this
Eclipse Help target.

n <Your Project Name> EPUB Conditioned text, topic, or document will be included in this EPUB
target.

n <Your Project Name> HTML Help 1.x Conditioned text, topic, or document will be included in
this compiled HTML Help target.

n <Your Project Name> JavaHelp Conditioned text, topic, or document will be included in this
JavaHelp target.

n <Your Project Name> Microsoft Help 2.0 Conditioned text, topic, or document will be included
in this MS Help 2.0 target.

n <Your Project Name> Microsoft Help Viewer Conditioned text, topic, or document will be
included in this Microsoft Help Viewer target.

n <Your Project Name> NetHelp Conditioned text, topic, or document will be included in this
NetHelp (browser-based uncompiled HTML Help) target.

n <Your Project Name> Manual Conditioned text, topic, or document will be included in this Prin-
ted Manual target (Word and PDF).

Any custom targets you create will also be included. See the online Help or the Targets Guide.
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ATTRIBUTES

n Two default attributes are included with Doc-To-Help (Internal and Release), but you create
your own. See "Creating and Using Attributes" on page 62.

EXAMPLES

If you’d like specific images to appear only in your printed output, you can mark those
graphics with the Platform condition named "Printed Manual."

Let's say you’d like links to related topics to be included only in your NetHelp output
(and excluded from your Manual targets). In that case, mark that text with the target
condition named "NetHelp."

Reminder notes to you and your team can be included in your project for reference, but
can be marked with the "Internal" attribute so that they are not included with the tar-
gets delivered to customers.

Suppose you’d like to output two different manuals: one for "Pharmacists" and one for
"Nurses." The nurses do not need certain administrative information. Therefore, create
an attribute condition for each audience. Mark the administrative information with the
"Pharmacist" attribute.
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Including Conditions in Your Output
If you have applied platform or target conditions to your text, topics, and/or documents, you don’t
need to do anything else but build your target(s). The appropriate information will automatically be
included in or excluded from your output.

If you have created and applied custom attributes in your project, you need to choose the attributes
for each target in the Help Targets dialog. See "Creating and Using Attributes" on the next page.
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Creating and Using Attributes
Attributes make it possible to assign user-defined build criteria to text, topics, documents, and
styles, which makes it possible to single-source one project several different ways. For example, you
could create both an Administrator and Manager version of a manual and/or Help system from the
same project.

Doc-To-Help has two default build attributes built in: Internal and Release.

HOW TO CREATE A NEW ATTRIBUTE

1. Open the Project ribbon.

2. From the Project ribbon group, click Attributes. The Attributes dialog opens.

3. Click the Add New Attribute button. An attribute named "NewAttribute" appears in the list.

4. Provide a name for the attribute. The NewAttribute name will initially be editable. If you wish
to change it later, select it, then click the Edit (pencil) icon.

EXAMPLE

An example of an attribute name would be "Audience." The Audience attribute
would then need values.

5. Click the Add New Value button. The new value appears in the list.

6. Replace the default text. The Value name will initially be editable. If you wish to change it
later, select it, then click the Edit (pencil) icon.

EXAMPLE

An example of attribute values for the Audience attribute would be "Pharmacist"
and "Nurse."
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HOW TO USE ATTRIBUTES

NOTE: After creating an attribute, you can assign it as any of the following:

n Text See "Marking Text as Conditional" on the next page.

n Topics See "Setting Topic Conditions" on page 66.

n Documents See "Finding Projects Containing a Source Document" on page 22.

1. Select the Target ribbon, and click the Target Properties button. The Help Targets dialog
opens.

2. On the left side of the dialog, select a target.

3. Click the drop-down on the Attributes field and choose the appropriate attribute(s) or create a
custom expression.

n Click the Attributes tab to assign one or more attributes to the target. Select the check
box(es) next to the appropriate attributes. The attributes chosen will display in the
Attributes field.

n Click the Expression tab to create a custom expression using your attributes. Expres-
sions are statements that combine attributes in more complex ways. The expression
created will display in the Attributes field.

After a particular target is built, the text, topic, or document flagged with those attributes will appear
in the output.
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Marking Text as Conditional
Using conditional text, you can mark specific text or graphics to display only in specific instances; by
platform, target, attribute, or a combination. This makes logical single-sourcing easy to accomplish.

HOW TO MARK TEXT AS CONDITIONAL

1. In the Word source document, select the text that you want to mark as conditional.

2. Select the Doc-To-Help ribbon.

3. In the D2HML Styles group, click Conditional Text. The Conditional Text dialog opens, with the
selected text displayed at the top of the dialog.

4. In the Conditional properties area select the appropriate options. You may select more than
one. After making your selection from the drop-down, click elsewhere in the dialog to close
the drop-down.

n Platforms Set a platform-based condition for the selected text. The text will be included
in all of the target platform(s) selected. A platform includes all the targets that produce
the output specified; Online Help, HTML Help, NetHelp, Printed Manual, etc.

n Targets Set a target-based condition for the selected text. The text will be included in
all the target(s) selected.

n Attributes Set an attribute-based condition for the selected text. The text will be
included or excluded when creating conditional builds (e.g., internal or external.) Use
the Attributes dialog to create custom attributes.

5. (Optional) Marking text as HTML passthrough code is an advanced feature that lets you
include HTML code in your document without Word treating that code as text. It is recom-
mended that the rich content variables feature be used instead of the HTML passthrough
code. With this feature, you can define a variable in an HTML document and insert it into a
Word document.

If you insert an HTML Help ActiveX Control into your Word document (also an advanced fea-
ture), that HTML code will be marked with the HTML passthrough condition.
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6. (Optional) In the Options area, you can select the following:

n Hide properties in document Puts the conditional text properties in the text.

OR

n Text in comment Puts the conditional text properties in a Word comment. 

7. Click OK.

NOTE: If you want to remove conditional text, you can use the Clear Formatting button in
the Doc-To-Help ribbon.

NOTE: You can also mark entire documents and topics as conditional.
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Setting Topic Conditions
You can set specific platform, target, and/or attribute conditions for a topic.

HOW TO SET TOPIC CONDITIONS

1. In the Topics Panel, select the topic.

2. Do one of the following:

n Right-click on the selected topic in the Topics Panel, and select Properties. Select the
condition(s) using the drop-downs in the Condition section.

n Open the Doc-to-Help ribbon, and click the Topic Properties button. Select the condition
(s) using the drop-downs in the Condition section.

No matter which method is used to set the conditions, they will always be displayed in the Topic
Properties dialog .

NOTE: Attributes must be specified in the Help Targets dialog to be properly included/ex-
cluded from the final output. See "Creating and Using Attributes" on page 62.

CHAPTER 5  66



CHAPTER 6

Glossaries
A glossary is a list of specialized words with their definitions, accessed in online output or placed at
the end of a PDF.

When you create a new project in Doc-To-Help, a glossary document is added automatically. You
can delete this document if you wish. If you’d like to flag a different document as your glossary, add
it to the project, right-click on it in the Documents pane, and from the menu choose Glossary.

Glossary entries are formatted by default with the Glossary Heading style, followed by the definition,
formatted as C1H Popup Topic Text. You can edit these styles to change this behavior. See the
online Help or the Design Guide.

Doc-To-Help can create automatic links to each glossary item, or you can create manual links to
glossary items (see "Links" on page 102). Choose the Link Type of Glossary Term. To set your pro-
ject to automatically create glossary links, open the Styles dialog and for the Glossary Heading Para-
graph style, select the Auto Glossary Links check box.

To add a glossary entry, you can open the glossary source document and add terms/definitions.
You can also use the Add Terms button in the Glossary section on the Doc-To-Help ribbon when
working in any Word source document. See "Adding Terms to the Glossary" on the next page.
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Adding Terms to the Glossary
If your project includes a glossary, you can quickly insert a glossary term while working in any Word
source document using the Doc-To-Help ribbon.

HOW TO ADD A TERM TO THE GLOSSARY

1. Open any Word source document.

2. Select the word you would like to add to the glossary. Select the Doc-To-Help ribbon. In the
Glossary section, click Add Terms. The Add Glossary Terms dialog opens.

3. Click on the Definition field to add a definition for the new term. If you would like to edit a term
name, choose it and click the Rename Term button.

4. Click the Add New Term button to add a new term at any time. In the Terms list, "New Term"
appears; rename this and add a definition.

5. (Optional) If you would like the new term to automatically link to its glossary definition every-
where in the project, select the Automatic links check box. A glossary term with this des-
ignation will be tagged with the Glossary Heading style, rather than the Glossary Heading (no
auto links) style.

6. Click OK.

To delete a term, select it from the list and click Remove Term.

HOW TO RE-ALPHABETIZE THE GLOSSARY

1. Open your Glossary document (DOC or DOCX) in Word.

2. Select the Doc-To-Help ribbon. In the Glossary section, click Sort. The Glossary terms are now
in alphabetical order.
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CHAPTER 7

Images
You can insert images into Word source documents, which are then included in your output.

This chapter discusses the following:

Recommended Location 70

Recommended Procedure for Inserting Images 71

Image Maps 72

Creating Image Maps 73

Splitting an Image Into Equal Hot Regions 75
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Recommended Location
A folder named "Media" is automatically created for Doc-To-Help projects. It is recommended that
you store your image files in that folder.

NOTE: If your source documents have a .docx extension, the Media folder should be a sub-
folder of the Documents folder (the folder in which Doc-To-Help stores all of your source
documents). This change can be made quickly using Windows Explorer.
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Recommended Procedure for Inserting
Images
When you insert an image in a Word source document, it is recommended that you use the following
steps.

1. Select Insert > Pictures. The Insert Picture dialog opens.

2. Find and select your image.

3. From the Insert drop-down, select Insert and Link.

NOTE: Cutting and pasting images into your documents is not a good best practice,
because it increases file size and makes your graphics hard to edit and manage.
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Image Maps
For online outputs, you can create hotspots from an image that link to topics, keywords, or groups.
See "Creating Image Maps" on the next page.

In addition, you can split an image (or a region you have already created) into equal hot regions. See
"Splitting an Image Into Equal Hot Regions" on page 75.
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Creating Image Maps
For online outputs, you can create hotspots from an image that link to topics, keywords, or groups.

Since the hotspots are only available in online outputs, you may want to add the same links under
the graphic for Manual outputs, then mark that text with the Printed Manual condition so it does not
appear in online output. See "Marking Text as Conditional" on page 64.

HOW TO CREATE AN IMAGE MAP

1. In the Word source document, select an image.

2. On the Doc-To-Help ribbon, click the Image Map Editor button. The Image Map Editor opens.

3. Do either of the following, depending on whether you want to draw a random region or split
the entire image into equal regions.

n Random Region Click the Draw Hot Region button and select a region.

n Split Into Equal Regions Click the Split into Hot Regions button . Complete the files in
the dialog and click OK when you are finished. See "Splitting an Image Into Equal Hot
Regions" on page 75.

Depending on the number of regions(s) you create, a default name for each region ("Hot
Region #") appears in the box on the right. It is in this area that you will create links to topics,
keywords, or groups.

NOTE: To rename a region, select the region name and click the Rename button .

4. In the box on the right, select a numbered Hot Region to which you want to assign a link.

5. Click the Set Hot Region Link button . The Link dialog opens.

6. From the Link type field, choose the kind of element to which you want to link: Topic title, Key-
word, or Group.

7. In the region below, choose the topic, keyword, or group.
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8. Click OK. The specified link is displayed in the Image Map Editor, under the list of numbered
Hot Regions. In the output, each region will display in a pop-up when the user hovers over that
area of the image.

NOTE: If you want to delete the link later, select it in the Image Map Editor and click
the Remove Hot link button .

9. (Optional) You can bring a region to the front or back, change the default line color for a
region, and zoom in or out using the toolbar on the top left.

10. (Optional) If you would like to adjust the coordinates of a region, select it and drag it on the
graphic, or for more precise adjustments use the Layout section on the right.

11. Click OK.
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Splitting an Image Into Equal Hot Regions
When working with image maps, you can split an image (or a region you have already created) into
equal hot regions. See "Creating Image Maps" on page 73.

HOW TO SPLIT AN IMAGE INTO EQUAL HOT REGIONS

1. In the Word source document, select an image.

2. In the Doc-To-Help ribbon, click the Image Map Editor button. The Image Map Editor opens.

3. (Optional) If you would like to split a previously created region, select that region in the
graphic.

4. Click the Split into Hot Regions button .

5. In the Split Into Hot Regions dialog, do one of the following:

n Split Entire Image Select the Split Entire Region radio button and enter the Row and
Column dimensions.

n Split a Region Select the Split selected hot region radio button and enter the Row and
Column dimensions. If you would like the original region to be deleted, select the Delete
the region after splitting it check box.

6. Click OK. 
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CHAPTER 8

Indexes
Index entries are also called "keywords" (or K-links). They will display in your output in an index.

In addition to the tasks discussed in this chapter, you can also create links to index keywords. See
"Links" on page 102.

This chapter discusses the following:

Creating Index Keywords in a Project 77

Creating Index Keywords in a Source Document 79
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Creating Index Keywords in a Project
Within your Doc-To-Help project, you can create index keywords and assign topics to them. You can
also create an index automatically.

HOW TO CREATE A KEYWORD AND ASSIGN TOPICS TO THEM

1. In Word, open the Index and Groups window view.

2. Click the Keywords button .

3. In the Keywords pane, click the Add New Keyword button in the local toolbar.

4. An editable keyword will be created, titled "New Keyword." Type the new keyword within the
box.

5. (Optional) To create a secondary keyword, select a keyword and click the Add Secondary Key-
word button in the local toolbar.

If a secondary keyword is assigned to a keyword, the primary keyword acts as a parent.

Topics may be assigned to all keyword levels.

Secondary keywordsmay be created several levels deep if you wish.

6. (Optional) Keywords can be renamed or removed using the Rename or Remove Keyword but-
tons in the local toolbar.
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HOW TO ASSIGN A TOPIC TO A KEYWORD

1. Create an index keyword.

2. In the Keywords/Groups pane, select the keyword to highlight it.

3. Drag a topic from the Topics window into the bottom half of the Keywords/Groups pane.

NOTE: You may assign more than one topic to a keyword. This will open a selection dialog
when the keyword is chosen from the index.

HOW TO CREATE AN INDEX AUTOMATICALLY (AUTO-INDEX)

If you’d prefer, Doc-To-Help can create an index for you automatically, based on your topic types.
From the Auto-Index drop-down list on the Project ribbon, choose the topic type(s) you’d like to
include in your index (you can select one topic type at a time). The next time you build your target,
topics with those topic properties will be included in the index. Topic types can be edited in the Pro-
ject Styles dialog. See the online Help or the Design Guide.

NOTE: For a complete listing of options, see the Index and GroupsWindow Pane topic in the
online Help.

NOTE: As an alternative to creating an index in the project, you can create an index by
inserting keywords in your Word source document. See "Creating Index Keywords in a
Source Document" on the next page.

NOTE: You can also create links to index keywords. See "Links" on page 102.
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Creating Index Keywords in a Source
Document
You can create an index by inserting keywords in your Word source document.

HOW TO INSERT AN INDEX ENTRY

1. In the Word source document, select the text to be used as an index keyword.

2. Select the Doc-To-Help ribbon.

3. In the D2HML Styles group, click Keyword. The Keyword dialog opens, and the selected text is
displayed at the top of the dialog.

4. (Optional) By default, keyword will be the selected text. The phrase "Keyword defined by Text"
is displayed in the Keyword field. If you would prefer to use another keyword, use one of these
options:

n If you would like to assign one or more existing keywords to the text, select the appro-
priate check box(es).

n If you would like to add a new keyword to the list and assign it, in the Keywords area,
click Add New Keyword. An editable keyword will be created, titled "New Keyword." Type
the new keyword within the box, and press Enter. Select the keyword check box.

To create a secondary keyword, select a keyword and click Add Secondary Keyword.
Type the new secondary keyword within the box, and press Enter. Select the keyword
check box.

5. (Optional) If you want to hide the tag, you can select the Hide properties in document. Clear-
ing the Visible check box will hide the text in your source document.

6. Click OK.

TIP: You can also insert keywords by dragging them from the Index and Groups window
pane in the Doc-To-Help Project panel to your source document. See "Drag-and-Drop Link-
ing" on page 106.
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NOTE: Any new keywords created using this method will also be added to the Index and
Groups window pane in Word. You can manage keywords from this window pane. See
"Creating Index Keywords in a Project" on page 77.

NOTE: Links to keywords are created using the Link dialog. Links can be text or buttons;
when selected, they display a dialog or popup window listing all the keyword topics. See
"Links" on page 102.
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CHAPTER 9

Margin Notes
Margin notes are used to place text or images in the left margin of a manual, next to the main body
of the text. Margin notes do not appear in online outputs unless you explicitly link them to the text,
where they will appear as popups.

HOW TO CREATE A MARGIN NOTE

1. In the Word source document, place your cursor at the point you’d like to insert the margin
note.

2. In the Doc-To-Help ribbon, click the Margin Note button and select Create.

A two-column table is placed in the document with the text of the paragraph in the right hand
table cell. If table gridlines are turned on in Word, you'll see a dotted outline of the table. The
gridlines do not print.

3. Type the margin note (or insert an image) in the left column of the table. The paragraph text
will be in the right column.

If you would like to add another margin note for the same paragraph, click in the left column, select
the Margin Note button and choose Add Definition.
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HOW TO CREATE A HOTLINK TO A MARGIN NOTE

1. After following the previous steps to create a margin note, highlight the text in the right
column that you want to use as a hotspot.

2. In the Doc-To-Help ribbon, click the Margin Note button and select Set Link.

3. A dialog confirms that you want to link the selected text with the contents of the highlighted
cell (i.e., the margin note). If it is correct, click OK. If not, use the Previous and Next buttons to
navigate to the proper cell.

The hotspot is created and will be indicated in the Word document with a comment that notes
the link information. If you would like to see this relationship more graphically, click in the right
column, then in the Doc-To-Help ribbon click the Margin Note button and choose Highlight
Definition Links.

NOTE: This is supported in online outputs only.
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CHAPTER 10

Multimedia
In the Doc-To-Help ribbon in Word source documents, there is an option named "Multimedia" that
lets you insert various types of multimedia (video and audio files).

This chapter discusses the following:

Supported Multimedia Types 84

Default Sizes 84

How to Insert Multimedia 85
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Supported Multimedia Types
You can insert the following types of multimedia:

n Flash Movies

n HTML5 Videos

n WindowsMedia Files

n QuickTime Movies

n YouTube Videos

n Vimeo Videos

Default Sizes
Following are the default sizes of videos when they are inserted:

n YouTube/Vimeo 560x315 pixels

n Flash Doc-To-Help uses size from SWF file

n QuickTime and HTML5 Width and height not set by default
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How to Insert Multimedia
1. In the Word source document, place your cursor where you want to insert the multimedia ele-

ment.

2. On the Doc-To-Help ribbon, click the Multimedia button. The Insert Multimedia dialog opens.

3. In the Source URL field, do one of the following:

n If you want to embed a YouTube or Vimeo video, paste the URL in the field.

n If you want to select a multimedia file, click . Then in the Open dialog, find and select
the file. If the file is located outside the project folder, there will be a message to copy
the file to the project folder.

4. (Optional) In the Alternative text field, you can type alternate text to display when the video is
not available, such as when a disabled individual is using a screen reader.

5. (Optional) Complete the rest of the options as necessary. The options shown depend on the
type of movie file you are inserting.

FLASH OPTIONS

n Size Specify the width and/or height in pixels or percentage.

n Movie

l Quality

o Low Favors playback speed over appearance and never uses anti-aliasing.

o Auto Low Emphasizes speed at first but improves appearance whenever pos-
sible. Playback begins with anti-aliasing turned off. If the Flash Player detects
that the processor can handle it, anti-aliasing is turned on.

o Auto High Emphasizes playback speed and appearance equally at first but sac-
rifices appearance for playback speed if necessary. Playback begins with anti-
aliasing turned on. If the actual frame rate drops below the specified frame rate,
anti-aliasing is turned off to improve playback speed. Use this setting to emulate
the View > Antialias setting in Flash.

o Medium Applies some anti-aliasing and does not smooth bitmaps. It produces a
better quality than the Low setting, but lower quality than the High setting.

CHAPTER 10  85



o High Favors appearance over playback speed and always applies anti-aliasing. If
the movie does not contain animation, bitmaps are smoothed; if the movie has
animation, bitmaps are not smoothed.

o Best Provides the best display quality and does not consider playback speed. All
output is anti-aliased and all bitmaps are smoothed.

l Scale

o Default Makes the entire movie visible in the specified area without distortion,
while maintaining the original aspect ratio of the movie. Borders may appear on
two sides of the movie.

o No border Scales the movie to fill the specified area, without distortion but pos-
sibly with some cropping, while maintaining the original aspect ratio of the
movie.

o Exact fit Makes the entire movie visible in the specified area without trying to
preserve the original aspect ratio. Distortion may occur.

l Alignment Select where you want the video to be displayed within the container area
(e.g., Left, Right, Bottom, Bottom Right).

n Playback

l Auto Play Select this option if you want the video to automatically begin playing
when the topic displays. Otherwise, the user must click the Play button to start the
movie.

l Loop Select this option if you want the movie to play repeatedly.

l Show Menu Select this option if you want to display the full menu, allowing the user a
variety of options to enhance or control playback. If you do not select this option, the
menu contains only the Settings option and the About Flash option.

l Enable SWLiveConnect Select this option to specify whether the browser should
start Java when loading the Flash Player for the first time.
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WINDOWS MEDIA OPTIONS

n Size Specify the width and/or height in pixels or percentage.

n Player Controls Select an option for displaying the player controls (e.g., Play, Pause,
Volume).

l None Does not display any player controls.

l Mini Displays only some of the player controls (Play, Pause, Stop, Mute, Volume).

l Full Displays all of the available player controls.

l Invisible Hides the movie entirely, while still playing the audio. If you select this
option, you might want to resize the container square in your topic so that it does not
take up so much space in the output. The user will simply see blank space where the
container exists.

n Playback

l Auto Start Select this option if you want the video to automatically begin playing
when the topic displays. Otherwise, the user must click the Play button to start the
movie.

l Full Screen Select this option to display the movie using the entire screen.

l Stretch to Fit Select this option to automatically resize the movie so that it exactly
matches the size of the container area.

l Play Count Enter the number of times you want the video to repeat.

n Audio Select options for the sound (mute, volume level, balance).

CHAPTER 10  87



QUICKTIME AND HTML5 OPTIONS

n Size Specify the width and/or height in pixels or percentage.

n Movie

l Scale

o To Fit Automatically resizes the movie so that it exactly matches the size of the
container area.

o Aspect Automatically resizes the movie so that it exactly matches the size of
the container area. However, the image is not stretched, but rather kept in its ori-
ginal proportion. For example, the width of the movie might be increased to
match the width of the container area, but extra empty space might be shown
above and below the movie in order to compensate for the height of the con-
tainer area.

o Value Enter the value that you want to increase the display of the movie. If you
select 2, the movie will be twice as large as 1, and so on.

n Player Controls

l Show Controls Select this option to show the player controls (e.g., Play, Pause). 

n Playback

l Auto Play Select this option if you want the video to automatically begin playing
when the topic displays. Otherwise, the user must click the Play button to start the
movie.

l Loop Select this option if you want the movie to play repeatedly.

n Audio Select the volume level for the movie.
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YOUTUBE OPTIONS

n Size Specify the width and/or height in pixels or percentage.

n Playback

l Auto Hide Select this option if you want to hide the video's title and player controls
bar when the movie begins playing.

l Auto Play Select this option if you want the video to automatically begin playing
when the topic displays. Otherwise, the user must click the Play button to start the
movie.

l Full Screen Select this option if you want to allow users to play the video in full-
screen mode.

l Show Related Videos Select this option if you want to show similar, suggested
videos when the movie stops playing.

l Annotations Select this option if you want to show annotations from the video owner
when viewing the movie.

o On Enables annotations from the video owner.

o Off Disables annotations from the video owner.

n Appearance

l Modest Branding Select this option if you want to remove the YouTube branding
from the player controls.

l Show Info Select this option if you want to show the title bar on the top of the video.

l Progress Bar Color Select the color you want to use for the player's progress bar.

o White Displays a white progress bar.

o Red Displays a red progress bar.

l Controls Select the display option for the player controls (i.e., play, pause, full-
screen, settings).

o On (Always) Displays player controls at all times.

o On (Only during playback) Displays player controls only during video playback.

o Off Disables player controls.
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l Theme Select a color theme for the player controls.

o Light Displays a light gray player control bar.

o Dark Displays a black player control bar.

NOTE: Some advanced features may not work in all web browsers.

NOTE: Setting the Progress Bar option to White overrides the Modest Branding
option, so you will always see the YouTube logo when you play your videos.

NOTE: If you disable the player controls, users will only be able to play and pause the
video. They will not be able to adjust the volume, view or adjust the progress bar,
change video settings, or open the video in full-screen mode.
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VIMEO OPTIONS

n Size Specify the width and/or height in pixels or percentage.

n Playback

l Auto Pause Select this option if you want the video to automatically pause when
another Vimeo video in the topic is played. Otherwise, the user must click the Pause
button to pause the movie.

l Auto Play Select this option if you want the video to automatically begin playing
when the topic displays. Otherwise, the user must click the Play button to start the
movie.

l Loop Select this option if you want the movie to play repeatedly.

n Appearance

l Byline Select this option if you want to display the video owner's name on the movie.

l Portrait Select this option if you want display the video owner's portrait on the
movie.

l Title Select this option if you want display the title on the video.

l Controls Color If you want change the color of the player controls, click and
select a color.

NOTE: Some advanced features may not work in all web browsers.

NOTE: If the owner of the video is a Vimeo Pro or Vimeo Plus member, some of these
settings may be overridden by that member's preferences. For example, an owner of
a video may not allow you to remove the title and byline, so you will still see this inform-
ation on the video even if you chose not to display it in the Doc-To-Help output.

NOTE: You cannot remove the Vimeo Staff Picks badge from a video.

6. Click OK. The multimedia is added to the document, represented by code that is translated
into the video or audio when the output is generated.
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CHAPTER 11

Navigation Links
A navigation link is a feature that points to additional information from a specific area in a topic or
document.

This chapter discusses the following:

Cross-References 93

Expanded, Drop-Down, or Popup Text 94

Expanding/Collapsing Sections 96

Groups 98

Links 102

Link Tags 107

Related Topics 108
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Cross-References
You can automatically add page references in printed manuals and hyperlinks in online outputs. The
page numbers will not appear in online output.

HOW TO INSERT AND COMPLETE A CROSS-REFERENCE

1. In the Word source document, place your cursor where you want the cross-reference to
appear.

2. In the Doc-To-Help ribbon, select Cross-reference > Cross-reference. The Cross-reference dia-
log opens.

3. Set the Reference type to Heading.

4. From the Insert reference to field, select Heading text.

5. From the displayed list, select the heading to which you want to link.

6. Click Insert. The heading text is inserted.

7. Click the Close button.

8. With the insertion point immediately following the cross-reference (reference field), go to the
Doc-To-Help ribbon and select Cross-reference > Complete Cross-reference.

9. The page reference is inserted and the heading text is enclosed in quotes. Also, the text is set
to "on page" by default. To change it, use the Project Settings dialog. See the online Help or
the Project Management Guide.

NOTE: You can also specify that all hyperlinks in your manual output remain active when
you create a PDF (links to website URLs will be live). To do this, open the Help Targets dia-
log, choose the Manual target and select the Live Links and Create Master Document
check boxes. Please note that popups will not become live links in manual or PDF formats
because those formats do not have a popup feature. See the online Help or the Project Man-
agement Guide.
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Expanded, Drop-Down, or Popup Text
You can use three different methods to display information that is initially not displayed in your out-
put:

n Expanded Text This displays content immediately after a selected link.

n Drop-Down Text This displays content under a selected link.

n Popup Text This displays content in a popup window when the link is selected.

HOW TO CREATE EXPANDED, DROP-DOWN, OR POPUP TEXT

1. In the Word source document, select the text you want to use as the link to open the hidden
content.

2. In the Doc-To-Help ribbon, click the Inline Text button. The Inline text dialog opens. The link
text is displayed in the Selection area.

3. In the Text box, enter the text to be displayed when the link is clicked in the output.

4. In the Options section, choose one of the following, depending on the kind of feature you want
to create:

n Expand text inline

n Dropdown text

n Show text in a popup

5. (Optional) If you would like the effect to be indicated as a comment in the source Word doc-
ument, select Text in comment.

6. Click OK.

7. Doc-To-Help displays a message box informing you that this is an invisible style (meaning the
expanded, drop-down, or popup text added will be not be displayed in the Word source doc-
ument—or in the output until the link is clicked). Since that is acceptable, click No to close the
message box. If you’d like to make this information visible, see the online Help or the Design
Guide.

NOTE: In EPUB outputs, expanding and drop-down text may be displayed or hidden. The
option you prefer can be set in the Help Targets dialog using the Show expanding text and
Show dropdown text check boxes.
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NOTE: It is also possible to create expanding/collapsing sections in HTML Help, NetHelp,
Microsoft Help Viewer, and Help 2.0 targets. See "Expanding/Collapsing Sections" on the
next page.
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Expanding/Collapsing Sections
For online output, you can create sections of content that are expanded or collapsed by default. 
This is an ideal way to subdivide a long topic in online documentation.

HOW TO CREATE EXPANDING/COLLAPSING SECTIONS

1. In the Word source document, select the header and the text that you would like to make into
a section.

EXAMPLE

An example header could be "San Diego State University." The text could be a
description of the university.

2. Select the Doc-To-Help ribbon.

3. In the D2HML Styles group, click Collapsible Section. The Collapsible Section dialog opens.
The selected text displays in the Header and Text areas.

4. If you would like the section to be expanded by default, in the Options area, select Expanded.
If you want the section to be collapsed by default, select Collapsed.

5. Click OK.

6. Continue creating sections. Note that the Heading for each section now has the C1H Section
Collapsed or C1H Section Expanded style applied to it.

NOTE: The heading for the section now has the C1H Section Collapsed or C1H Section
Expanded style applied to it.

NOTE: The header will be displayed in the online output with a + and - control next to it.
When the user clicks on the control, the text will be displayed or hidden. The Expand All or
Collapse All control at the top of the topic will allow the user to expand/collapse all of the
text at once.
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EXAMPLE

This is an example of a topic with sections collapsed by default. Doc-To-Help auto-
matically added the Expand All control at the top of the topic.

NOTE: The Generate XHTML check box in the Help Targets dialog must be selected to
enable expanding/collapsing sections.

NOTE: In EPUB targets, all content in collapsible sections will be displayed (just as it would
in manual targets).
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Groups
Groups can also be referred to as "related topics" or "associative topics" (A-links). When a group of
topics is related, a link can be created in your online output that displays a dialog or popup window
displaying the list of topics in that group. Groups do not display in the index.

The following is an example of a popup menu displayed when a user clicks a group link. The user
can then choose one topic from the menu and follow it.

Following are the main tasks you can perform when it comes to groups:

n Create Groups can be built quickly and easily using the Index and Groups window pane and
the Topics window in Doc-To-Help. See "Creating Groups" on the next page.

n Add Topics to Groups After creating a group, you can add a topic to it. See "Adding a Topic to
a Group" on page 101.

n Create Links You can create links to groups. See "Links" on page 102.

NOTE: Although groups are sometimes referred to as "related topics," they are a bit dif-
ferent from those that are created in the Related Topics window pane. The links created in
the Related Topics window pane are subtopic links that are automatically added to the bot-
tom of topics. See "Related Topics" on page 108.
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Creating Groups
Groups can be built quickly and easily using the Index and Groups view in the Doc-To-Help Project
Panel.

HOW TO CREATE A GROUP

1. In Word, open the Index and Groups view in the Doc-To-Help Project panel.

2. Click the Groups button .

3. In the Groups pane, click the Add New Group button in the local toolbar.

4. An editable group name will be created, titled "New Group." Type the new group name within
the box.

5. (Optional) Groups can be renamed or removed using the Rename or Remove Group toolbar
buttons.

HOW TO ASSIGN A TOPIC TO A GROUP

1. Create a group.

2. In the Keywords/Groups view, select the group to highlight it.

3. Drag a topic from the Topics window into the bottom half of the Keywords/Groups view.
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NOTE: Groups should always have more than one topic assigned to them.

NOTE: For a complete listing of options, see the Index and GroupsWindow View topic in the
online Help.
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Adding a Topic to a Group
After creating a group (see "Creating Groups" on page 99), you can add a topic to it.

HOW TO ADD A TOPIC TO A GROUP

1. In the Word source document, select text.

2. Select the Doc-To-Help ribbon.

3. In the D2HML Styles group, click the Group button. The Group dialog opens, and the selected
text is displayed at the top of the dialog.

4. (Optional) By default, the topic will be added to a group whose name is defined by the selec-
ted text. The phrase "Group defined by Text" is displayed in the Group field. If you would prefer
to add the topic to another group, use one of these options:

n If you would like to add the topic to an existing group (or groups), select the appropriate
check box(es).

n If you would like to add a new group to the list, in the Groups area, click Add New Group.
An editable group will be created, titled "New Group." Type the new group name within
the box, and press Enter. Select the group(s) check boxes.

5. (Optional) If you want to hide the tag, you can select the Hide properties in document. Clear-
ing the Visible check box will hide the text in your source document.

6. Click OK.

NOTE: You can also create and manage groups from the Index and Groups view in the Doc-
To-Help Project panel in Word.
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Links
You can create links to topics, bookmarks, link tags, keywords, groups, and glossary entries.

HOW TO CREATE A LINK

1. In the Word source document, select the text where you want to create a link.

2. Select the Doc-To-Help ribbon.

3. In the D2HML Styles group, click Link. The Link dialog opens.

4. Click the Link type drop-down and choose the type of link you would like to create.

n Topic title

n Topic in Document

n Link tag

n Bookmark in Document

n Keyword

n Group

n Glossary term

5. In the area below, select the appropriate topic, link tag, bookmark, keyword, group, or glossary
entry.

If a particular topic has been deleted as a result of the latest build (e.g., it was conditioned out
of the target), it will be listed with a red X icon. But in this dialog you can create links to such a
deleted topic without first rebuilding a target that is conditioned to include it.
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EXAMPLE

Let's say you place a condition on a topic called "References" so that it is included
only in a Manual target. When you build a NetHelp target, that topic is excluded
from the output, and a red X is shown next to it in the Topics window.
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Then let's say you are working in a source document and you begin to insert a
link. In the Link dialog, you can see that the References topic has been removed
as a result of the most recent build. But you are still able to select this topic when
linking to it, in anticipation of building the Manual target in the near future (where
that topic will be included).

TIP: You can click or to view the "link to" information in Grid View or Tree View.

NOTE: You may select more than one keyword or group.
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NOTE: For topic links, the default target topic will be identical to the selected text.
The phrase "Defined by Text" is displayed in the Topic field.

6. (Optional) Depending on the link type, you can make selections in the Link options area.

If you would like the information to display in a popup, select the Popup check box (if it is avail-
able for the selected link type).

By default, the window type of the topic is chosen. If you would prefer the destination topic to
display in another window type, choose one from the drop-down list.

NOTE: The (Default) topic window types are set using topic types, which are one
component of a paragraph style. These are set for the project in the Styles dialog.
See the online Help or the Design Guide.

7. (Optional) In the Options section, you can select Hide properties in document to hide the tag.

8. (Optional) In the Options section, you can select Show as button if you would like the link to be
a button in the online output with the selected text displayed on it.

9. Click OK.

NOTE: Using drag-and-drop linking, you can create links in your Word source document.
You can use drag-and-drop linking from the Word Doc-To-Help Project panel. See "Drag-
and-Drop Linking" on the next page.

NOTE: If you would like to create a new keyword, group, or link tag, see "Creating Index Key-
words in a Source Document" on page 79, "Adding a Topic to a Group" on page 101, or "Link
Tags" on page 107. You can also create/edit keywords and groups using the Index and
Groups view in the Doc-To-Help Project panel.
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Drag-and-Drop Linking
If you prefer, you don’t need to use the Link button to create links to topics, keywords, groups, and
documents—or the Variable button to insert text variables.

Using drag-and-drop linking, you can create links to your Word source document from the Doc-To-
Help Project panel in Word.

HOW TO CREATE A DRAG-AND-DROP LINK

1. Open your Word source document.

2. Open the Doc-To-Help Project panel (Project ribbon>Project Panel).

3. In the Doc-To-Help Project panel, select the appropriate window pane for the type of link you
want to create:

n Document Select the Documents window pane.

n Keyword or Group Select the Index and Groups window pane. Click (default) in the
toolbar to display the project keywords (Index); click to display the project groups.

n Topic Select the Contents window pane.

n Variable Select the Variables window pane.

4. Select the topic, keyword, group, document, or variable you want to link to, and drag it into
your document. The link will be created in your document.

NOTE: Using drag-and-drop linking will create a direct link to the topic, keyword, group, or
document selected. If you would like to choose a specific destination window or book-
mark—or specify that the link should appear as a Popup—you should use the Link dialog
instead.
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Link Tags
A link tag is a unique identifier for a topic, and makes it possible to create a jump or popup link to a
topic. If a paragraph style has the Auto Link check box selected, then Doc-To-Help will automatically
create a link tag for every topic using that style . Automatic link tags are identical to the topic title,
but spaces, hyphens, and periods are replaced by underscores.

Sometimes you may need to manually create a unique link tag for a topic, particularly if you have
two or more topics with the same name, and therefore the same link tag. The Link Tag dialog makes
this possible. A topic can have more than one link tag, and can be viewed in the Topics window
(right-click and select Columns>Link Tag from the context menu).

HOW TO ADD A LINK TAG MANUALLY

1. In the Word source document, select text where you want to add the link tag.

2. Select the Doc-To-Help ribbon.

3. In the D2HML Styles group, click the Link Tag button. The Link tag dialog opens. The selected
text is displayed at the top of the dialog.

4. (Optional) By default, the link tag will be the selected text. The phrase "Link tag defined by
Text" is displayed in the Link Tag field. If you would prefer to use another link tag, use one of
these options:

n If you would like to assign a link tag to the text, select it in the Link tags area.

n If you would prefer to use another link tag, you can add a new link tag to the list. To do
this, in the Link tags area, click Add New Link Tag. An editable link tag is created, titled
"New Link Tag." Type the new link tag within the box and press Enter.

5. (Optional) If you want to hide the tag, you can select the Hide properties in document. Clear-
ing the Visible check box will hide the text in your source document. See the online Help or the
Design Guide.

6. Click OK.

TIP: If you want to link to a topic title that will change with each build (e.g., some text is con-
ditioned or it includes a dynamic variable), create a link tag and link to it to avoid broken links
when the text changes.
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Related Topics
Related topics (also known as "subtopic links") can be created/edited and viewed using the Related
Topics pane and the Topics window. The related topics feature is very powerful, because it lets you
customize relevant "See Also" links for any topic, without the need to create individual cross-ref-
erence links. Combined with the automatically created subtopic relations, this means your online
outputs can help your users find the exact topic they need, when they need it. It can also eliminate
topic "dead ends" in your online output.

By default, related topics will display at the bottom of an online topic like this:

Using the Related Topics view, you can add additional subtopic links to a topic, as well as disable or
hide links.
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AUTOMATIC SUBTOPIC LINKS

Subtopic links are created automatically by Doc-To-Help based on heading styles. They display in
online outputs at the bottom of the topic.

By default, the related subtopics are the children of the main topic (Heading 1 styles will display
Heading 2 styles as subtopics; Heading 2 styles will display Heading 3 styles.) The display of sub-
topic links is controlled by the topic type of the heading style, and can be turned on/off in the Project
Styles dialog using the Auto Subtopic Links check box. See the online Help or the Design Guide.

In the bottom section of the Related Topics view, these automatic relations are flagged as "Sub-
topics."

You can note where any topic displayed in the lower half of the Related Topics pane belongs in the
topic hierarchy by selecting it and clicking the Go to Related Topic button in the local toolbar.

The Filter icon can be used to easily search through any of the Subtopics.
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HOW TO CREATE A CUSTOM RELATION TO A TOPIC

1. Open the Related Topics window view and select a topic. This topic could already have auto-
matic subtopics, custom related topics, or no related topics.

2. Go to the Topics window, select the desired related topic, and drag it into the lower half of the
Related Topics view. The new relation will be flagged as a "Custom Related Topic."

This custom relation will display in the Related Topics list for that topic after the target is
rebuilt.

HOW TO REMOVE A CUSTOM RELATION

n Choose the relation and click the Remove Relation button.

HOW TO HIDE SUBTOPIC LINKS

If you would prefer that the entire related topics list does not display in a specific topic.

1. Open the Related Topics window view and select the topic.

2. In the local toolbar, click the Disable Subtopic Relations button.

In the bottom section of the Related Topics view, the message will read "Subtopic Relations
Disabled by User."
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HOW TO CHANGE THE RELATED TOPICS LABEL FOR ALL TOPICS

1. Select the Target ribbon.

2. Click the Target Properties button. The Help Targets dialog opens.

3. From the list on the left, choose the appropriate online target.

4. Change the Label field. (By default, the label is "More:").

HOW TO CHANGE THE RELATED TOPICS LABEL FOR A SINGLE TOPIC

1. Open the Topics Panel window and select the topic.

2. Select the Doc-To-Help ribbon, and click Topic Properties.

3. Edit the Related Links Label field in the Topic Properties window.

HOW TO CHANGE THE STYLE OF THE RELATED LINKS LABEL AND LINKS

1. Select the Target ribbon.

2. Click the Target Properties button.The Help Targets dialog opens.

3. From the list on the left, choose the appropriate online target.

4. Change the Label style and/or Links style field(s).
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CHAPTER 12

Tables
You can quickly insert a table into a Word document using the Special Formatting toolbar or ribbon.
The table will be pre-formatted with the correct Doc-To-Help styles, and you can specify borders,
indentation, and shading of the heading row.

HOW TO INSERT A STANDARD TABLE

1. In a Word source document, place your cursor at the point you’d like to insert a table.

2. In the Special Formatting ribbon, click the Standard DocToHelp Table button. The Standard
Doc-To-Help Table dialog opens.

3. Specify the number of Rows and Columns.

4. Select the desired check boxes to add a border (Create borders), align the table with the Body
Text style (Indent table to align with Body Text), and shade the heading row gray (Fill
heading).

5. To make additional adjustments to your table, select it and right-click. From the menu, choose
Table Properties.

6. Click OK.

NOTE: The Special Formatting toolbar or ribbon will not be displayed in all templates. In
those cases, use the regular table functions found in Word.
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NOTE: If you want to use the Special Formatting ribbon in your source document, be sure
to select the D2H_SMAL.dotx, D2H_SMAL_A4.dotx, D2H_NORM.dotx, or D2H_NORM_A4.-
dotx template when creating a new document. If your source document is using a different
template, and you switch to one of these four templates, the Special Formatting ribbon will
not be available.
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CHAPTER 13

Tables of Contents
Doc-To-Help automatically creates a table of contents (TOC) for you based on the structure of your
documents. But you can create a custom TOC (you can even have different TOCs for different tar-
gets) if you wish.

AUTO-GENERATED TOC STRUCTURE

An auto-generated TOC will be structured as follows:

n The order of the TOC will be determined by the order of the documents in the Documents win-
dow pane.

n Heading 1 styles with no Heading 2 styles under them will appear at the main level

n Heading 1 styles with Heading 2 styles under them will appear at the main level as "books,"
with the Heading 2 styles indented below them.

n If used, Heading 3 styles will be indented under Heading 2 styles; Heading 4 styles under Head-
ing 3 styles.

n If a Heading 1 style has no Heading 2 styles under it, it will not appear as a book in the TOC. It
can be changed to one, but when the project is built it will not retain the book icon, because
there are no subtopics under it.
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The book icon visually indicates that "more information is available" about a topic.

By default, Heading styles 1-4 will be included in an auto-generated TOC. If you would like to add a
Heading style to the TOC, open the Styles dialog and clear the Explicit access check box for that
paragraph style. See the online Help or the Design Guide.

You can see which topics are included in your TOC by opening the Topics window and looking at the
TOC column.

NOTE: You can also view the topics in your TOC when you are working in Word by opening
the Doc-To-Help Project Panel (Doc-To-Help > Project Panel), and selecting the Contents
window pane. If you are working with a target-specific TOC, select the target from the drop-
down at the top of the panel to see the topics in a specific target.

NOTE: If your TOC is auto-generated, and you add a new topic to your project, that topic will
automatically be added to the TOC the next time a target is built.
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HOW TO CREATE A CUSTOM TABLE OF CONTENTS

1. In Word, open the Contents window pane.

2. Add, delete, reorder, and rename TOC items as you wish.

n Add a Topic to the TOC Drag it from the Topics window into the Contents pane.

n Move a TOC Item Up or Down Choose it in the Contents pane and click the Move Up or
Move Down buttons .

n Change the Level of a TOC Item Choose it in the Contents pane and click the Move Out
or Move In buttons .

n Create a New, Empty Book Choose a spot in the Contents pane and click the Create
Book button .

n Convert a TOC Item to a Book (Must Have Subtopics) Choose it in the Contents pane,
right-click, and choose Convert Topic to Book.

n Rename a TOC Item Choose it in the Contents pane and click the Rename Topic button
.

n Delete a TOC Item Choose it in the Contents pane and click the Remove Topic button
.

As soon as you manually edit the TOC, it will be flagged as "Customized." If you would like this TOC
to be exclusively used for the target selected, click the Target-Specific Table of Contents button.

Once you have customized a TOC, any topics added to your project must be added manually, unless
you have the Update customized table of contents in build check box is selected in Project Settings.
Choosing this option will automatically add newly-created topics to your customized TOC when your
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project is built, although you will want to open the Contents window pane and confirm their location.
To view the new topics added after a build, open the Topics Panel, click the Filter View button, and
choose Show only topics added in the last build. If you have deleted any topics, those will need to be
deleted manually from the TOC. Target-specific TOCs will not be updated.

NOTE: In a Manual target, topics in multi-topic documents will always appear in the TOC in
the same order as they appear in the source document. If the order is changed in the TOC,
Doc-To-Help lists an error in the build log and does not use the customization.

HOW TO CREATE A TARGET-SPECIFIC TABLE OF CONTENTS

1. In the Target ribbon, click the Active Target button and choose the desired target.

2. In the Doc-To-Help project panel, open the Contents view.

3. Manually edit the TOC.

4. Click the Target-Specific Table of Contents button .

Continue choosing targets to customize each one.

HOW TO REBUILD THE TOC BASED ON DOCUMENT STRUCTURE

1. In the Target ribbon, click the Active Target button and choose the desired target.

2. Open the Contents window pane.

3. Click the Rebuild Table of Contents button .

NOTE: For a complete listing of TOC options and instructions, see the Contents Window
Pane (Doc-To-Help) topic in the online Help.
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CHAPTER 14

Topics
To make your Word document more useful for online output, it is broken up into smaller elements
called "topics," which are based on the heading styles in the document. After you create a Doc-To-
Help project and build some output from it, Doc-To-Help automatically creates multiple topics as a
result, structuring the content for online documentation. Heading 1 styles in your Word document
automatically become parent topics, and all of the Heading 2 styles under a Heading 1 style become
subtopics. Just keep in mind that these topics are not created until you build at least one target in
your project.

This chapter discusses the following:

Example 119

Windows 122

Tasks Associated With Topics 123

Adding, Renaming, and Deleting Topics 124

Printing and Exporting the Topic List 126

Setting D2HML Topic Properties 129

Viewing/Changing Topic Properties 132
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Example
Following is an example of topics in Doc-To-Help.

EXAMPLE

The following shows a project containing two Word documents, one that contains the
main content and a second being used as a glossary. No targets in this project have
been generated yet. Therefore, no topics exist right now.
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After building a target, notice that the Topics panel is populated, based on the heading
styles in the Word source document. In this case, multiple topics were created from
the two source documents. It also shows the structure of the table of contents that will
be created in the output.
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The Contents window view in the Doc-To-Help Project panel in Word is also populated.
You can use the Contents view in the Doc-To-Help Project panel to quickly view the
structure of the document, jump to locations in the source document, or create links.
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Windows
Topics can be managed a number of ways in Doc-To-Help. This includes specifying topic properties
and conditions, as well as creating indexes and tables of contents.

The primary location for working with topics is the Topics window.
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Tasks Associated With Topics
Following are the primary tasks associated with topics:

n Add, Rename, and Delete Topics may be added, renamed, and deleted from a Word document
using the Doc-To-Help ribbon. See "Adding, Renaming, and Deleting Topics" on the next page.

n Assign Topics to Index KeywordsWithin your Doc-To-Help project, you can create index
keywords and assign topics to them. See "Creating Index Keywords in a Project" on page 77.

n Create Custom Tables of Contents You can create a custom table of contents (you can even
have different TOCs for different targets). See "Tables of Contents" on page 114.

n Print or Export Topic List You may print your entire topic list, and also export it to Microsoft®

Excel® or text (TXT) if you wish. See "Printing and Exporting the Topic List" on page 126.

n Set D2HML Topic Properties Specific topic properties may be set using D2HML. See "Setting
D2HML Topic Properties" on page 129.

n View and Change Topic Properties The properties of specific topics—for example, the topic
title and type (conceptual, procedural, etc.), and condition—may be reviewed and edited. See
"Viewing/Changing Topic Properties" on page 132.
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Adding, Renaming, and Deleting Topics
Topics may be added, renamed, and deleted from a Word document using the Doc-To-Help ribbon.
Adding a topic using this method makes it possible to perform certain functions (e.g., creating a link
to the new topic) without building the target first. The topic that is added, renamed, or deleted will
automatically be updated in the table of contents (unless the TOC is customized).

You can also add a topic by entering the text and applying a heading style. Existing topics can also
be renamed or deleted by editing or deleting the topic text. When using these methods, make sure
to build the target to incorporate your changes.

HOW TO ADD A NEW TOPIC

1. Open your Word source document (.doc or .docx).

2. Place your cursor at the point you’d like to insert the new topic. This should be at the start of a
new paragraph. (Place an empty paragraph at the end of the previous topic.)

3. Open the Doc-To-Help ribbon, and click the Add button . You will be asked to confirm the new
topic location. Click Yes. The Add Topic dialog opens.

4. Enter the Title of the topic and from the drop-down list choose the Style. The location of the
new topic displays in the topic hierarchy.

5. Click OK.

HOW TO RENAME A TOPIC

1. Open your Word source document (.doc or .docx).

2. Select the entire name of the topic you wish to rename.

3. Open the Doc-To-Help ribbon, and click the Rename button . The Rename Topic dialog opens.
The name and location of the topic will be bolded in the topic hierarchy.

4. Change the Title of the topic and, if you wish, from the drop-down list choose a different Style.
The URL, ASCII Name, Link tag, and Keyword will be changed by default to use the new title
(see "Viewing/Changing Topic Properties" on page 132). If you would prefer any or all of these
properties do not change, clear the check box(es).

5. Click OK.
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HOW TO DELETE A TOPIC

1. Open your Word source document (.doc or .docx).

2. Select the entire text of the topic(s) you wish to delete.

3. Open the Doc-To-Help ribbon, and click the Delete button . The Delete Topics dialog opens.
The name and location of the topic(s) will be bolded in the topic hierarchy.

4. Click OK.
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Printing and Exporting the Topic List
You may print your entire topic list, and also export it to Microsoft® Excel® or text (TXT) if you wish.
Exporting your topic list is useful if you’d like to sort or filter your topics, or if you’d like to provide a
list of topics and context IDs to your software development team for the implementation of context-
sensitive Help. See the online Help or the Context-sensitive Help Guide.

n "Exporting the Topic List" below

n "Printing the Topic List" on the next page

Exporting the Topic List
Exporting your topic list is useful if you’d like to sort or filter your topics, or if you’d like to provide a
list of topics and context IDs to your software development team for the implementation of context-
sensitive Help. See the online Help or the Context-sensitive Help Guide.

HOW TO EXPORT THE TOPIC LIST

1. Open the Project ribbon, and click the Topics Panel button.

2. Click the Print and Export drop-down on the Topics Panel.

3. From the Export to… list, choose Excel or Text.

4. The Save As dialog opens.

5. Choose the file location and name.

6. Click OK.
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Printing the Topic List
Before printing the topic list, you may preview it, change the page settings, and/or choose from
three print options.

HOW TO PRINT THE TOPIC LIST

1. Open the Project ribbon and click the Topics Panel button.

2. Click the Print and Export button.

3. On the Topics Panel, click the drop-down for the Print and Export button.

4. From the list of options, choose Print. The Print dialog opens.

5. Select the options you’d prefer and click OK.

HOW TO PREVIEW THE TOPIC LIST

1. Open the Project ribbon and click the Topics Panel button.

2. On the Topics Panel, click the drop-down for the Print and Export button.

3. From the list of options, choose Preview. The Print Preview dialog opens.

4. In the upper-left, click the Print button, or click the Close button to close the Print Preview dia-
log.

HOW TO CHANGE THE TOPIC LIST PAGE SETTINGS

1. Open the Project ribbon and click the Topics Panel button.

2. On the Topics Panel, click the drop-down for the Print and Export button.

3. From the list of options, choose Page Settings. The Page Setup dialog opens.

4. Choose the paper size, orientation, and margins.

5. Click OK.
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HOW TO CHOOSE A PRINT OPTION FOR THE TOPIC LIST

1. Open the Project ribbon and click the Topics Panel button.

2. On the Topics Panel, click the drop-down for the Print and Export button.

3. From the list of options, choose Print Options. The Print Options dialog opens.

4. Select the check box next to the appropriate option

n Fit to page width The list will scale so that it is only one page wide.

n Fit to entire page The list will scale so that it all fits on a single page.

n Extend last column The last column of the list will be extended on the printed page.

5. Click OK.
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Setting D2HML Topic Properties
Topic properties may be set using D2HML (Doc-To-Help Markup Language).

HOW TO SET D2HML TOPIC PROPERTIES

1. Select the Doc-To-Help ribbon and click Topic Properties. The D2HML Topic Properties dialog
opens.

2. Make changes in the different sections of the dialog.

GENERAL

n ASCII Name Specifies the ASCII-only string used to identify the topic in situations where
non-ASCII characters are not allowed. This property is important for authoring in lan-
guages that have non-ASCII alphabets, such as Cyrillic and Asian languages. In some
instances, names generated by Doc-To-Help must be ASCII. Such instances include
identifiers in *.h and *.bas map files that are used for context-sensitive Help in C and
Visual Basic programming language.

n URL Specifies the name of the generated HTM file for this topic. You can edit the name
manually, or you can set a rule for it in the Project Settings dialog ("URL mode" field).
You can also limit the character length of this URL using the "Truncate file name length"
field in the Project Settings. Another way to edit the URL is to double-click in the URL
cell in the Topics Panel and type it there.

n Context ID The unique numeric identifier assigned to the topic during compilation (read-
only). This allows the topic to be used in context-sensitive Help. Context ID settings are
managed in the Project Properties dialog. See the online Help or the Context-sensitive
Help Guide.

n Comments An editable text box for comments by the author. These comments are not
accessible by the end user.

n Default Topic If selected, this will be the topic displayed when online output is opened
(the "home page"). The default topic can also be set by selecting a topic in the Topics
window, right-clicking, and choosing Default Topic.
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APPEARANCE

n Contents Title This field lets you change the topic title in the table of contents (Con-
tents pane) without changing the actual topic title in the source document. See "Tables
of Contents" on page 114.

n Display Title This field allows for modification of a topic title with respect to searches
without changing the actual topic title in the source document. Use this property to add
qualifying text to like-named topics. For example, a search for "intro" may yield several
topics named Introduction, but by modifying the Display Title, you can force results
such as Introduction (Help Authoring) and Introduction (HTML), without adding the text
in parentheses to the source documents. This is the equivalent of adding a<Title> in
HTML.

n Related Links Label Specifies the text that precedes the subtopic buttons for this topic.
If you clear this field, there will be no text above the buttons. If you would like to change
the label text for a specific target, change it in the Help Targets dialog. The default label
is More: See "Related Topics" on page 108.

n Include in Search If selected, search is enabled for this topic in NetHelp targets. If
cleared, this topic is excluded from the search.

n Disable Comments If checked, DISQUS commenting will be disabled for this topic. See
the online Help or the Targets Guide.

CONDITION

n Platforms Sets a platform-based condition for the selected topic. The topic will be
included in all the target platform(s) selected. A platform includes all the targets that
produce the output specified; Online Help, HTML Help, NetHelp, Printed Manual, etc.
See "Conditions" on page 56.

n Targets Sets a target-based condition for the selected topic. The topic will be included
in all the target(s) selected. See "Conditions" on page 56.

n Attributes Set an attribute-based condition for the selected topic. The topic will be
included or excluded when creating conditional builds (e.g., internal or external.) Use
the Attributes dialog (Project > Attributes) to create custom attributes. See "Conditions"
on page 56 and "Creating and Using Attributes" on page 62.

n Disable Comments If checked, DISQUS commenting will be disabled for this topic. See
the online Help or the Targets Guide.

3. Click OK.
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NOTE: For information about making adjustments to other topic properties, see "View-
ing/Changing Topic Properties" on the next page.

NOTE: Topic properties will be hidden by default.
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Viewing/Changing Topic Properties
The properties of specific topics—for example, the topic title and type (conceptual, procedural,
etc.), and condition—may be reviewed and edited in the Topic Properties dialog.

Certain topic properties can be edited in the Topics window itself (e.g., type, context ID, keywords,
and groups). Simply click in the grid at the appropriate spot to open a drop-down or activate the
field. (To see the columns available for display, right click in the window and choose Columns.)

If you would like to view or change the properties of an entire document, use the Document Prop-
erties dialog. See "Setting Document Properties" on page 19.

HOW TO VIEW AND CHANGE TOPIC PROPERTIES

1. Open the Topics window, right-click the desired topic, and choose Properties. The Topic Prop-
erties dialog opens.

NOTE: If you would like to edit multiple topics, choose them in the Topics window
using SHIFT+Click or CTRL+Click. Right-click and choose Properties.

2. Make any necessary changes in the dialog.

GENERAL

n Title The name of the topic, taken directly from the source document. This field is read-
only. To change a topic title in a Word source document, use the Rename button on the
Doc-To-Help ribbon.

n Topic type Specifies a named set of display, navigation, and indexing characteristics to
be associated with this topic (such as what window the topic appears in, how the topic
is accessed, and whether it gets a map number).

n ASCII Name Specifies the ASCII-only string used to identify the topic in situations where
non-ASCII characters are not allowed. This property is important for authoring in lan-
guages that have non-ASCII alphabets, such as Cyrillic and Asian languages. In some
instances, names generated by Doc-To-Help must be ASCII. Such instances include
identifiers in *.h and *.bas map files that are used for context-sensitive Help in C and
Visual Basic programming language.

n URL Specifies the name of the generated HTM file for this topic. You can edit the name
manually, or you can set a rule for it in the Project Settings dialog ("URL mode" field).
You can also limit the character length of this URL using the "Truncate file name length"
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field in the Project Settings. Another way to edit the URL is to double-click in the URL
cell in the Topics Panel and type it there.

n Context ID The unique numeric identifier assigned to the topic during compilation (read-
only). This allows the topic to be used in context-sensitive Help. Context ID settings are
managed in the Project Properties dialog. See the online Help or the Context-sensitive
Help Guide.

n Context string When using context-sensitive (F1) and dynamic Help with Microsoft Help
2.0, this option specifies the context string for the topic. Each topic can have one or
more context strings, or none. The context strings must be separated by a semicolon.
Topic context strings form a hierarchical tree structure. A context string consists of
dot-separated context names for each hierarchy level. See the online Help or the Con-
text-sensitive Help Guide.

EXAMPLE

A topic "Property MyProperty" can have the following:

l Context string = "MyCompany.MyProduct.MyProperty"

Topic "Properties MyProperty1 and MyProperty2" can have the following:

l Context  string = "MyCom-
pany.MyProduct.MyProperty1;MyCompany.MyProduct.MyProperty2"

n Comments An editable text box for comments by the author. These comments are not
accessible by the end user.

n Default Topic If selected, this will be the topic displayed when online output is opened
(the "home page"). The default topic can also be set by selecting a topic in the Topics
window, right-clicking, and choosing Default Topic.
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APPEARANCE

n Contents Title This field lets you change the topic title in the table of contents (Con-
tents pane) without changing the actual topic title in the source document. See "Tables
of Contents" on page 114.

n Display Title This field allows for modification of a topic title with respect to searches
without changing the actual topic title in the source document. Use this property to add
qualifying text to like-named topics. For example, a search for "intro" may yield several
topics named Introduction, but by modifying the Display Title, you can force results
such as Introduction (Help Authoring) and Introduction (HTML), without adding the text
in parentheses to the source documents. This is the equivalent of adding a<Title> in
HTML.

n Related Links Label Specifies the text that precedes the subtopic buttons for this topic.
If you clear this field, there will be no text above the buttons. If you would like to change
the label text for a specific target, change it in the Help Targets dialog. The default label
is More: See "Related Topics" on page 108.

n Hide Subtopic Links If selected, the subtopic links will be hidden for this topic.

n Include in Search If selected, search is enabled for this topic in NetHelp targets. If
cleared, this topic is excluded from the search.

n Disable comments If checked, DISQUS commenting will be disabled for this topic. See
the online Help or the Targets Guide.

CONDITION

These can also be set and will appear in the Condition ribbon group. See "Conditions" on page
56.

n Platforms Sets a platform-based condition for the selected topic. The topic will be
included in all the target platform(s) selected. A platform includes all the targets that
produce the output specified; Online Help, HTML Help, NetHelp, Printed Manual, etc.

n Targets Sets a target-based condition for the selected topic. The topic will be included
in all the target(s) selected.

n Attributes Set an attribute-based condition for the selected topic. The topic will be
included or excluded when creating conditional builds (e.g., internal or external.) Use
the Attributes dialog (Project > Attributes) to create custom attributes. See "Creating
and Using Attributes" on page 62.
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MODULE LINK

For more about modular output, see the online Help or the Project Management Guide.

n Target menu Before setting your module link properties, choose the appropriate mod-
ular target from the drop-down.

n Module file For a placeholder topic in a modular hub project, specifies the platform-
dependent Help file to be loaded dynamically. (Applies only to HTML Help, NetHelp, and
Microsoft Help Viewer 1.x modular hub projects.)

n Contents file For a placeholder topic in a modular hub project, specifies the platform-
dependent contents file to be loaded dynamically. (Applies only to HTML Help modular
hub projects.)

n Use first topic as parent For Microsoft Help Viewer modular hub projects, sets the first
topic in the child project as the parent of the other topics in the child project.

n Inherit Product name For Microsoft Help Viewer modular hub projects, sets the product
name for the child projects to the same value as that of the hub project. The product
name value is set in the Help Targets dialog of the hub project.

n Inherit Book name For Microsoft Help Viewer modular hub projects, sets the book name
for the child projects to the same value as that of the hub project. The book name value
is set in the Help Targets dialog of the hub project.
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CHAPTER 15

Variables
Variables allow you to write content once, and manage it in one place for reuse across your project
because variable hotspots are replaced with variable text in the final output. There are two basic
kinds of variables: text and rich content. Both are created in the Variables window in Doc-To-Help—
and you can create rich text variables from the Doc-To-Help Project panel in Word.

This chapter discusses the following:

Text Variables 137

Rich Content Variables 143

Variables and Conditions 144

Inserting a Variable 145
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Text Variables
Text variables may be used for any amount of non-formatted text. They will use the formatting that
is used at their insertion point in the document.

When adding a new text variable, you can select one of three types: Text, Version, or Date/Time.

If you want to use text variables, you need to create them first.

HOW TO CREATE A TEXT VARIABLE

1. In Word, click the Variables view in the Doc-To-Help Project panel.

2. Select one of the following in the Text Variables area:

n Text A text variable is the type that has been used in previous versions of Doc-To-Help.
This lets you enter simple text.

n Version This lets you enter a version in one of four available formats:

l 1

l 1.0

l 1.0.0

l 1.0.0.0

If you click the Build button, unchanged documents won't be processed, so variables
won't be updated in those unchanged documents when you view the output, although
they will be incremented in the Variables window where you created them.

If you want to force variables to update in all documents, you need to click Rebuild
instead. Each time you click the Rebuild button for a target that has the variable, the ver-
sion values are incremented automatically—whether the documents have changed or
not—in both the output and the Variables window.

When version variables are updated, only the last part of the number is incremented
automatically.
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EXAMPLE

Let's say you create a version variable with the 1.0.0 format, insert it into
a document, and build a target.

If you rebuild the target, the variable changes in the output to 1.0.1.

If you rebuild again, it changes to 1.0.2.

If the variable value reaches 1.0.9 and you rebuild, it changes to 1.0.10,
then 1.0.11, then 1.0.12, and so on.

NOTE: You can open the Variables window and change the variable value
manually at any time.

NOTE: The variable value is incremented only if this variable was used in build-
ing the current target, so all variables that were excluded from the build pro-
cess due to their condition won't be changed.

n Date/Time These variables get their values either from current system date/time, or
from file date/time attributes. This means that you cannot set its value manually (for
this purpose, you can use simple "text" type variables).

3. An editable field named "New Variable" displays in the Name cell. In the Name cell, enter a
name for the variable.
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4. Depending on the variable type you selected, the Definition cell is populated with either simple
text, 1.0.0.0, or a date/time format. Double-click in the Definition cell and provide the value for
the variable.

n Text If you double-clicked on a cell for a text variable, simply type text.

n Version If you double-clicked on a cell for a version variable, enter the starting version
number.

n Date/Time If you double-clicked on a cell for a date/time variable, a popup displays.
Complete the fields in it:

l Format Specifiers This is the date/time format. You can select a format from the
drop-down, or you can type a format manually. Specifiers are based on Microsoft's
custom date and time format strings. For details of the specifiers available, see
http://msdn.microsoft.com/en-us/library/8kb3ddd4.aspx.

NOTE: You can make a word part of the definition. For example, you
might want the word Date with a colon and a space before a date string
(e.g., Date: October 25, 2014). The issue is that certain characters are
translated automatically as specifiers. So just typing the word Date
wouldn't work. The easiest solution is to put the non-specifier characters
within quotation marks. Therefore, you might enter "Date:" MMMM dd,
yyyy.

l Update Select how you want the variable to display the date and time. You can
choose any of the following:

o On Document Creation The variable displays the date and time that you cre-
ated the document.

o On Document Save The variable displays the date and time that you last saved
the document.

o On Build The variable displays the date and time of the most recent project
build.
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5. (Optional) If want to associate a condition with the variable, double-click in the Condition
column and choose a Platform, Target, or Attribute condition for the variable.

n Platforms Set a platform-based condition for the variable. The text will be included in all
of the target platform(s) selected. A platform includes all the targets that produce the
output specified (Online Help, HTML Help, NetHelp, Printed Manual).

n Targets Set a target-based condition for the variable. The text will be included in all the
targets selected.

n Attributes Set an attribute-based condition for the variable. The text will be included or
excluded when creating conditional builds (e.g., internal or external). Use the Attributes
dialog (Project ribbon > Attributes) to create custom attributes.

If you would like to assign more than one condition to a variable, select the variable's name
and click the Add Definition with Condition toolbar button. An additional definition row will be
created. Enter the appropriate definition, then double-click in the Condition column to set a
condition. One text variable can have multiple unique outputs.

TIP: It is recommended that you make a different version variable for each target
and then assign conditions to those variables. This is quite useful because the ver-
sion numbers are then incremented separately for each target. On the other hand, if
you create only one version variable and use it in several targets, the version number
will increment after each rebuild of any of those targets.
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EXAMPLE

Let's say you have a NetHelp target and a Manual target.

In the Variables window, you create a version variable named "NetHelp" with a
starting value of 1.0. Then you create another version variable named "Manual"
with a starting value of 1.26. Finally, you create a third version variable named
"Shared" with a starting value of 3.9.

Next, for the NetHelp variable, you double-click the Condition cell. In the Tar-
gets field (in the popup), you select NetHelp (or whatever your target is called).

Then, for the Manual variable, you double-click the Condition cell. In the Targets
field (in the popup), you select Manual (or whatever your target is called).

Next, you insert all three variables in a source Word document.

You build the NetHelp target for the first time. In the output, the variable num-
bers are as follows:

n NetHelp 1.0

n Shared 3.9

n Manual Not shown because it was conditioned out

Now you build the Manual target for the first time. In the output, the variable
numbers are as follows:

n Manual 1.26

n Shared 3.10

n NetHelp Not shown because it was conditioned out

Next, you rebuild the NetHelp target. In the output, the variable numbers are as
follows:

n NetHelp 1.1

n Shared 3.11

n Manual Not shown because it was conditioned out
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Finally, you rebuild the Manual target. In the output, the variable numbers are as
follows:

n Manual 1.27

n Shared 3.12

n NetHelp Not shown because it was conditioned out

NOTE: After creating a variable you cannot change its type.

NOTE: Although you cannot create text variables while you are working in Word, you can
hover over any text variable in the Variables window pane (Doc-To-Help > Project Panel) to
view its definition.
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Rich Content Variables
Rich content variables may be used for blocks of formatted content. They are stored in source doc-
uments and will use the formatting applied to the variable itself.

EXAMPLES

n Tables

n Images or other media

n Formatted company names

n Entire topics

If you want to use rich content variables, you need to create them first. You can create a rich con-
tent variables document in Word, and add new variables to it .

HOW TO ADD NEW RICH CONTENT VARIABLES

1. Open your Word source document.

2. Open the Doc-To-Help Project panel (Doc-To-Help > Project Panel).

3. Select the Variables window pane.

4. In the Variables area, double-click the rich content variable document to open it. The rich con-
tent variable document will have a table with two columns in it.

NOTE: You need to create a rich variables document in Doc-To-Help before a doc-
ument will appear in the Variables window pane.

5. In the left column, enter a variable name (without spaces in it).

6. In the right column, enter the variable content.

7. Apply styles to the variable content as desired, including conditional text.

8. Save the document.
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Variables and Conditions
You can assign conditions to text variables, providing even more flexibility for their use. If you’d like,
you can create a single variable, and assign multiple text values and conditions for it. This lets you
insert a variable once, and have different text be used in each of your conditions.

Conditions can be especially useful if you have multiple targets and want version numbering to be
incremented separately for each target. After creating multiple version variables, you can associate
target conditions with each one. On the other hand, if you create only one version variable and use it
in several targets, the version number will increment after each rebuild of any of those targets.

Rich content variables can include text that has been conditioned.
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Inserting a Variable
After you create a variable, you can insert it into your Word source document.

HOW TO INSERT A VARIABLE

1. In the Word source document, place your cursor where you want to insert a variable.

2. Select the Doc-To-Help ribbon.

3. In the D2HML Styles section, click Variable. The Variable dialog opens.

4. Select the appropriate variable from the grid.

5. (Optional) In the Options section, select the Hide properties in document check box to hide
the tag.

6. Click OK.

TIP: You can also insert variables by dragging them from the Variables window pane in the
Doc-To-Help Project panel to your source document. See "Drag-and-Drop Linking" on page
106.

NOTE: When your target is built, the value of the variable(s) used is automatically inserted
in the output. For text variables, the value will have the same formatting (font, etc.) as its
insertion point. For rich content variables, the variable will retain the formatting applied to
the variable when it was created.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

On the Doc-To-Help Start Page, click the PDF Guides icon to access them.

Context-sensitive Help Guide Shortcuts Cheat Sheet

Design Guide Targets Guide

Documents, Templates, and Content Guide Touring the Workspace Guide

Getting Started Guide Upgrading Old Projects Guide

Getting Started Tutorial What's New Guide

Project Management Guide
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